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Introduction
Welcome to the Autodesk MapGuide Enterprise Server and Studio 2010 Essentials Autodesk Official
Training Guide, a training guide for use in Authorized Training Center (ATC®) locations, corporate
training settings, and other classroom settings.
Although this guide is designed for instructor‐led courses, you can also use it for self‐paced learning.
The guide encourages self‐learning through the use of the Autodesk MapGuide® Enterprise Server
2010 and Autodesk MapGuide® Studio 2010 Help systems.
This introduction covers the following topics:
■
Guide objectives
■
Prerequisites
■
Using this guide
■
CD contents
■
Installing the exercise data files from the CD
■
Notes, tips, and warnings
■
Feedback
This guide is complementary to the software documentation. For detailed explanations of features and
functionality, refer to the Help in the software.

Objectives
After completing this guide, you will be able to:
■
■
■
■
■
■
■
■

Describe the MapGuide Enterprise Server and Studio system.
Install and configure MapGuide Enterprise server on Microsoft Windows.
Use MapGuide Studio to load data, build layers, create maps, and establish a web layout.
Create and cusotmize Flexible and Basic web layouts.
Describe Server, FDO, Viewer, and Studio APIs.
Connect PHP Reports to a Web Layout.
Enhance MapGuide Server, Studio, and data performance.
Describe native Google Earth support.

ix

Prerequisites
This guide is designed for the student new to Autodesk MapGuide 2010.
It is recommended that you have a working knowledge of:
■
Fundamentals of geographic information systems.
■
Microsoft® Windows® XP or Microsoft® Windows® Vista.

Using This Guide
The lessons are independent of each other. However, it is recommended that you complete
these lessons in the order that they are presented unless you are familiar with the concepts and
functionality described in those lessons.
Each chapter contains:
■
Lessons
Usually two or more lessons in each chapter.
■
Exercises
Practical, real‐world examples for you to practice using the functionality you have just learned.
Each exercise contains step‐by‐step procedures and graphics to help you complete the exercise
successfully.

CD Contents
The CD attached to the back cover of this book contains all the data and drawings you need to
complete the exercises in this guide.

Installing the Exercise Data Files from the CD
To install the data files for the exercises:
1.
2.
3.

Insert the courseware CD.
When the setup wizard begins, follow the instructions on screen to install the data.
If the wizard does not start automatically, browse to the root directory of the CD and double‐click
setup.exe.

Unless you specify a different folder, the exercise files are installed in the following folder:
C:\Projects
After you install the data from the CD, this folder contains all the files necessary to complete each
exercise in this guide.

x
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Notes, Tips, and Warnings
Throughout this guide, notes, tips, and warnings are called out for special attention.
Notes contain guidelines, constraints, and other explanatory information.

Tips provide information to enhance your productivity.

Warnings provide information about actions that might result in the loss of data, system failures,
or other serious consequences.

Feedback
We always welcome feedback on Autodesk Official Training Guides. After completing this guide, if you
have suggestions for improvements or if you want to report an error in the book or on the CD, please
send your comments to learningtools@autodesk.com.
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Chapter

1
Introduction to Autodesk
MapGuide Enterprise
In this chapter, you review the high‐level key components that make up Autodesk MapGuide®
Enterprise. The Autodesk MapGuide® Studio, an integral part of MapGuide Enterprise, is introduced.
Feature data objects (FDO) and their associated providers are also introduced. You are introduced to
all the components that make up a MapGuide solution.

Objectives
After completing this chapter, you will be able to:
■
■
■

Describe the key components of Autodesk MapGuide Enterprise.
Explain the four key processes to publish data to the web with Autodesk MapGuide Studio.
Explain Feature Data Objects (FDO) and its data providers.

1

Lesson: Introduction to Autodesk MapGuide
Lesson: Server
In this lesson, you explore the various components of the Autodesk MapGuide Enterprise Server.
Autodesk MapGuide Enterprise is a server‐based product that uses powerful and flexible architecture
to provide information via the Web.

MapGuide Enterprise Server Service in Windows

Objectives
After completing this lesson, you will be able to:
■
■
■

2

■

Describe the components of the MapGuide Enterprise Server.
List the types of Web Server Extensions.
Explain the function of the MapGuide Site Administrator.

Chapter 1: Introduction to Autodesk MapGuide Enterprise

About MapGuide Server
Autodesk MapGuide Enterprise Server is the primary web engine that hosts the spatial application
services. These services enable you to produce maps, combine data, filter information and perform
GIS analysis within a server‐side environment. It is installed in conjunction with a web server including
Apache and Microsoft Internet Information Services (IIS).
Autodesk MapGuide Enterprise server has three components:
■
Server Service
■
Web Server Extensions
■
Site Administrator

Windows and Linux Support
Autodesk MapGuide Enterprise can be installed on either Microsoft Windows Server. MapGuide also
supports Linux Red Hat Enterprise.

Microsoft Windows and Red Hat Linux are supported

Regardless of which operating system is used, Autodesk MapGuide Enterprise can be installed on one
or more physical web servers that can share services.
Microsoft Windows XP or Vista and Autodesk MapGuide Enterprise
Autodesk MapGuide Enterprise can run on Microsoft Windows XP Professional or
Vista for demonstration purposes. XP and Vista are not officially supported but can be
used in a training environment with limited users.
There are two ways to access information from Autodesk MapGuide Enterprise:
■
From files stored directly on the Autodesk MapGuide Enterprise Server that is loaded with
MapGuide Studio.
■
From data that is linked to the Autodesk MapGuide Enterprise Server with Feature Data Objects
(FDO) connections.
The data repositories arestored as XML files that reside on Autodesk MapGuide Enterprise Server
where the file‐based GIS files are also stored. These repositories are used by Autodesk MapGuide
Enterprise to provide mapping objects. The repositories aremainlycreated and managed in Autodesk
MapGuide Enterprise by using Autodesk MapGuide Studio.

Lesson: Introduction to Autodesk MapGuide Server
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MapGuide Web Server Services
Some of the the key services performed by MapGuide Enterprise Server.
Service

Description

Site

Configures users, groups, and user sessions.

Client

Generates the client interface or wrapper in HTML.

Drawing

Allows low‐level access to drawing sources (DWF™ data).

Feature

Provides access to FDO providers.

Resource

Manipulates resources and repositories.

Mapping

Provides access to maps and layers within a map.

Rendering

Renders a map into a bitmapped image.

These services can be accessed programmatically with the three different Web Server Extensions.

About MapGuide Web Server Extensions
Autodesk MapGuide Web Server Extensions are the Internet interfaces that communicate with the
Autodesk MapGuide Server and its repositories.

Types of Web Server Extensions
Currently, there are three development types of the Web Server Extensions, using:
■
Java (JSP)
■
Microsoft ASP.NET
■
PHP

Java
The Java Web Server Extension is extremely versatile. Autodesk MapGuide Server can run Java on
Linux or Windows. Java Server Pages (JSP) can be written to run on any Java‐enabled server, but
Apache Tomcat is the only Java server that is supported by MapGuide Server. Since Apache Tomcat
can be installed on either the Linux or Windows server, any code written in JSP that accesses the
Autodesk MapGuide Application Programming Interface (API) will be supported.

4
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Microsoft ASP.NET
The ASP.NET Web Server Extension is used solely with Microsoft Windows and IIS. It is a free scripting
language that is part of the Microsoft .NET Framework that runs with IIS. The MapGuide APIs are
available for ASP.NET using tools such as Visual Studio .NET. ASP.NET, C#, or VB.NET (languages that are
used to ask for maps, manipulate features, or perform geographic analysis).

Operating system and development languages for Autodesk MapGuide Enterprise

The Autodesk MapGuide Enterprise .NET web extension will only work on WIndows
with Internet Information Services (IIS).

The PHP Web Server Extension
The Autodesk MapGuide Server Site Administrator requires the PHP web server extension to run
regardless of operating system. PHP is widely used as web application framework. PHP (Hypertext
Preprocessor) is Open Source, and its syntax is a blend of Java, Perl, and C languages. PHP can also be
installed in either Linux or Windows Server, so the PHP code written to access Autodesk MapGuide will
be portable to either operating system.
Regardless of the operating system (Windows or Linux), PHP is required for Autodesk MapGuide Server
Site Administrator. This does not require that all customization be programmed in PHP. Microsoft
ASP.NET can be used if Autodesk MapGuide is installed on a Windows server running IIS. JSP can be
used if Windows or Linux is the operating system as long as Tomcat is also running and Autodesk
MapGuide Web Server Extensions are installed.

Lesson: Introduction to Autodesk MapGuide Server
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About MapGuide Site Administration
The web‐based Autodesk MapGuide Site Administrator manages the Autodesk MapGuide sites. Each
site has a collection of servers that process requests from Autodesk MapGuide. Each site shares a
single XML‐based resource repository among its servers. The resource repository stores the resources
that map authors use to create maps and web layouts.

Site Administrator
You use the Site Administrator to manage the MapGuide site. You can add and remove servers or take
them offline for maintenance using the web interface.

Autodesk MapGuide Site Administrator

MapGuide Server has seven services but the overall processing load can be divided between two or
more servers within the site. The site server always runs the Site and Resource services because they
handle data access and manage the resources for the site.
You can allocate the Drawing, Feature, Mapping, Rendering, and Tile services to another server or
servers using the Autodesk MapGuide Site Administrator. Mapping and Rendering services are the
most processor‐intensive operations and can benefit from having a dedicated server to handle them.
On a single server, all services are processed together.

6
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Users, Groups, and Roles
You use the Site Administrator to define users and groups and to assign roles to users or groups for:
■
Viewing the maps
■
Creating the maps (Author)
■
Administering the site
WFS and WMS users are created to give access to those OpenGIS services.
All user and group security for Autodesk MapGuide is managed from within the Site Administrator and
is separate from Windows or Linux security.

User management in MapGuide Site Administrator

Lesson: Introduction to Autodesk MapGuide Server
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Lesson: Introduction to Autodesk MapGuide
Lesson: Studio
In this lesson, Autodesk MapGuide Studio and its relationship to MapGuide Enterprise is explored.
You view how MapGuide Studio is used to publish maps and deploy spatial applications on either
MapGuide Open Source or Autodesk MapGuide Enterprise.

Autodesk MapGuide Studio

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■

8
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Describe the MapGuide Studio workflow.
Load and configure data within Studio.
Create and modify layers.
Create maps with assigned coordinate systems.
Describe web and print layouts.
Explain the difference between AJAX and DWF viewers.

Chapter 1: Introduction to Autodesk MapGuide Enterprise

About Autodesk MapGuide Studio
Introduction to MapGuide Studio Functions
With Autodesk MapGuide Studio you can prepare all aspects of geospatial data and mapping. You can
use Autodesk MapGuide Studio to do the following:
■
Log in to Autodesk MapGuide Server using its Administrator URL.
■
Manage the content in the repositories on Autodesk MapGuide Server.
■
Load or connect to geospatial data.
■
Stylize geospatial data.
■
Publish maps created in Autodesk MapGuide Studio on the Internet.

MapGuide Studio Interface
The Autodesk MapGuide Studio interface is divided into three parts:
■
Site Explorer
■
Preview Pane
■
Edit Pane

Autodesk MapGuide Studio panes

Lesson: Introduction to Autodesk MapGuide Studio
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Workflow
When you are using Autodesk MapGuide Studio, the workflow consists of these four steps:
■
Find data.
■
Build layers.
■
Make a map.
■
Place the map on the Internet.

Access to Site Explorer
To access the Site Explorer, you open Autodesk MapGuide Studio and connect to the site server (for
example, http://www.autodesk.com/mapguide2010/).
The Site Explorer shows the resources that are stored in the resource repository. Double clicking any
resource in the Site Explorer opens the associated editor for that resource.
Split or Preview buttons show the graphical representation of the layer being edited and will appear in
the Preview Pane.

Finding Data
There are two ways to find data within Autodesk MapGuide Studio:
■
Use the Load Procedure function to upload spatial data
■
Configure spatial data already on the server

Load Spatial Data
You can use Load Procedure to upload data into Autodesk MapGuide Enterprise using MapGuide
Studio in any of the following data file formats:
■
SDF (Including legacy SDF2.0 files used by Autodesk MapGuide 6.x)
■
SHP
■
DWF
■
DWG™
■
DXF™
■
Raster (geo‐referenced)

10
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Configure Spatial Data
Not all spatial data needs to be loaded; only configured. Autodesk MapGuide Server uses Autodesk
Feature Data Objects (FDO) to make database connections or direct connections to files already on
the server. (It is assumed that Autodesk MapGuide Enterprise has access to the files or enterprise
databases through the appropriate client software such Oracle Instant Client or ArcSDE Client or
through network permissions.)
With the live FDO connections to the corporate spatial database, Autodesk MapGuide Enterprise
provides real‐time mapping information without having to load new files with MapGuide Studio. The
FDO method of data connection is by far the more efficient method of serving data with Autodesk
MapGuide Enterprise.

Building Layers
After you load spatial data or configure FDO connections, you can use those data sources to make
individual layers. You complete the stylization of each layer at this stage.

Data Resource selection dialog

Data Types
There are three types of data in Autodesk MapGuide:
■
Drawing source (DWF)
■
Feature source (FDO, SHP, SDF)
■
Raster source (JPG, MR SID, etc.)

Drawing Source Data
For drawing source data, you can set the scale ranges and choose the layouts and layers to view. With
DWF files, the stylization of the DWG is preserved within the file and no stylization is required.

Lesson: Introduction to Autodesk MapGuide Studio
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Feature Source Data
For feature source data (lines, points, polygons), features can be themed based on a property (for
example, color code parcels based on price) or just stylized based on data type such as line, point,
or polygon. You can create symbols and put them in the symbol library. You can stylize points with
symbols, which are similar to how blocks are used in AutoCAD®.
The supported symbols include BMP, JPG, EMF, WMF, PNG, and DIB.

Style Area for Polygons

Raster Source Data
For raster source data, the settings are scale range and rebuild factor; for bi‐tonal images the off and
on bits can be colored. Raster images must be geo‐referenced to be used with Autodesk MapGuide
Studio.

12
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Scale Ranges
All types of data sources can have scale ranges applied. A scale range is used to determine the scale at
which a layer turns on, or is themed. By using the scale to drive the way the particular layer is drawn,
the performance of the overall map can be increased dramatically.

Scale Ranges shown for a SDF Polygon layer

Since each layer references a data source, you can have more than one layer point to the same data,
depending on what is required of that data. For example, on a road map, the roads can be stylized with
red lines, and on a municipal map the roads may be stylized with black lines.

Making Maps
Once the layers are configured and stylized, you use the Map Editor to specify basic map settings and
to add layers. The name of the map, used primarily for printing, is set in the Map Editor at this stage.

Coordinate Systems
You also assign the map coordinate system at this step. Since each of the data sources were assigned
a coordinate system either during the data load or when the data source was configured, each layer
added to the map will be re‐projected according to the map's coordinate system.

Lesson: Introduction to Autodesk MapGuide Studio
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Layers
Layers are added to the map. By setting the Drawing Order, you can adjust the visual display order for
each layer within the map.
For example, the Parcel layer is usually drawn below the Building layer so that parcels do not obscure
the buildings from view.

Map Drawing Order dialog box

Groups
You can categorize the layers on the map into groups. For easy management of the layers and to
provide a "clean legend," you can nest or sub‐group the groups.

Map Layer Grouping dialog box

14
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Placing Maps on the Internet
Basic Web Layouts
After you create a map, you need a web layout so that users can view and interact with the map on the
Internet or an intranet. As with the Map Editor, you can preview the layout in the Web Layout Editor.
One map per web layout is required. After you choose a map for the web layout, you can modify three
sections of the final layout and hide functionality from view:
■
Left Pane: Layers and properties
■
Middle Pane: Toolbar, context menu, status bar, and map
■
Right Pane: Task bar and pane
Autodesk MapGuide Studio offers full control over the toolbar and menus. Many standard functions,
such as zoom, pan, select, or the ability to create a new button or menu item, makes it very simple to
customize the web layout.

Web Layout
Basic Web Layouts
Basic Web Layouts enable you to choose between AJAX (images) or DWF (ActiveX)
viewers.
DWF is not available in the Flexible Web Layouts.

Lesson: Introduction to Autodesk MapGuide Studio
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Flexible Web Layouts
The new Flexible Web Layouts include support for Overview Maps, selected attributes, and measuring
tools. There are a series of templates within Autodesk MapGuide Studio that you can use to create a
web application that has pre‐existing tools such as custom menus and overview maps.

Flexible Web Layout templates in Studio

16
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Print Layouts
Print layouts are used for custom printing a map from a browser. When printing from the map layout,
the user can choose any custom print layout in Autodesk MapGuide Studio.
The print layout is an XML definition that describes which web layout elements to include in the DWF
ePlot that is sent to the printer.
The following elements can be included and modified within a print layout:
■
Background color
■
Title
■
Legend
■
Scale bar
■
North arrow
■
URL
■
Date and time
■
Custom logo
■
Custom text

Print layout

The print layouts only work with the DWF Viewer. Customization of a print layout
requires knowledge of XML.

Lesson: Introduction to Autodesk MapGuide Studio
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About Viewers
There are two Autodesk MapGuide viewers:
■
DWF Viewer
■
AJAX Viewer
Both versions refer to the same web layout in Autodesk MapGuide Studio, but are rendered using
separate URLs.

DWF and AJAX Viewer URLs in Studio

Autodesk Design Review
The Autodesk® Design Review is a Microsoft ActiveX control created by Autodesk®. Using a
combination of HTML and the DWF Viewer, Autodesk MapGuide can show the custom interface
created by the web layout in Autodesk MapGuide Studio.
The DWF Viewer only works with Microsoft Windows and Internet Explorer and requires installation
of the Autodesk Design Review ActiveX control in order to view the web layout in the browser.
Some advantages of using the DWF Viewer are:
■
Increased performance with client‐side API and selecting without posting back to the server.
■
Superior printing found with the DWF using print layouts.
■
Statically created maps taken offline to be viewed without network activity or Internet.

AJAX Viewer
The AJAX Viewer (or “zero‐client viewer”) does not require a download or installation of any
applications on the browser. It supports many browsers including Firefox or Internet Explorer and
operating systems such as Windows, Macintosh OS, or Linux.
Using AJAX (Asynchronous JavaScript + XML) methodology, JavaScript is used to generate dynamic
mapping by consuming XML without having to reload the page. This interface looks almost identical to
the DWF‐based viewer but has images rather than DWF files.
Some advantages of the AJAX Viewer are:
■
View maps on almost any web browser.
■
View maps on almost any operating system.
■
Requires no client installation.
■
Use with Flexible Web Layouts.
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Lesson: Feature Data Objects ‐ FDO
In this lesson you learn about Feature Data Objects (FDO). FDOis a technology that provides a way
to access many different geospatial data sources through a common mechanism. The data sources
include a variety of geospatial databases and file formats. It is flexible and meets the needs of many
client applications including Autodesk MapGuide Enterprise, MapGuide Open Source, and AutoCAD®
Map 3D.

FDO bridges Autodesk products to data

Objectives
After completing this lesson, you will be able to:
■
■

Describe the FDO data providers.
Explain the uses of the FDO API.

Lesson: Feature Data Objects - FDO
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About Feature Data Objects ‐ FDO
Autodesk Feature Data Objects (FDO) is a set of Application Programming Interfaces (APIs) for
connecting Autodesk products to various native data stores. For example, Autodesk MapGuide can
connect directly to Oracle Spatial, ArcSDE, or the OpenGIS Web Map Service (WMS).
Although Autodesk MapGuide Studio can run load procedures to convert or place SHP, SDF, DWG,
DWF, and DXF files on the server, it is more efficient to connect directly to the live geographic
databases without uploading them to the server or translating files.
FDO provides a single interface to all corporate data, so that the underlying data behind the layers
and maps in Autodesk MapGuide Enterprise is automatically updated. FDO is also used with Autodesk
MapGuide Enterprise to update and maintain information so that there is a seamless process of
creating, editing, maintaining, and distributing spatial data within any organization.

FDO Providers
Since there are many direct FDO connections to data that do not require loading files on the server,
FDO is the most efficient enterprise method of distributing spatial data in Autodesk MapGuide
Enterprise.
Autodesk MapGuide Enterprise includes the following providers:
■
Autodesk FDO Provider for Oracle
■
Autodesk FDO provider for Raster
■
Autodesk FDO Provider for SQL Server
■
OSGeo FDO Provider for ArcSDE
■
OSGeo FDO Provider for MySQL
■
OSGeo FDO Provider for ODBC
■
OSGeo FDO Provider for SDF
■
OSGeo FDO Provider for SHP
■
OSGeo FDO Provider for SQL Server Spatial
■
OSGeo FDO Provider for WMS
■
OSGeo FDO Provider for WFS
Many of the FDO Providers also need the associated client software to run. For example, if the
Autodesk FDO Provider for Oracle is used, then the Oracle Instant Client needs to be installed on the
server.
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For Raster, SDF, and SHP files to be directly connected with FDO without loading
the files with Autodesk MapGuide Studio, an alias is required. You create an alias in
Autodesk MapGuide Enterprise Site Administrator.

External file alias in Site Administrator

FDO Application Programming Interface (API)
You use the Autodesk FDO API for creating, managing, and examining information, enabling Autodesk
GIS products to seamlessly share spatial and non‐spatial information, with minimal effort.
Typically, the learning curve is quite steep for each set of new corporate GIS APIs that need to be
integrated within the system. For example, if an organization that typically uses Oracle Spatial and
Autodesk MapGuide Server wants to connect to the ArcSDE database in another department, then
they need to learn ArcSDE APIs and the client so that the products can be integrated.
Now, with FDO API, there is a single point of entry and one API to communicate to all the different
spatial databases. With all the different FDO providers, there is little need to learn the API for each
of the different GIS databases. The FDO API can access all the geographic features; you can create,
edit, and delete objects regardless of the source GIS. FDO API is very flexible and has many tools for
accessing the capabilities of the connected GIS database or files. For example, some FDO data sources
may support spatial queries.
The FDO API model provides a consistent method for accessing spatial data while still providing the
ability to perform queries and analysis for those GIS databases that support it.
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Direct Access to FDO API
FDO is installed with AutoCAD Map 3D and Autodesk MapGuide Enterprise. In AutoCAD Map 3D, the
C++ and C# APIs are exposed directly. However, in Autodesk MapGuide Enterprise, the .NET (C# and
VB.NET) APIs are the only direct API into FDO.
Even without the direct access to the FDO, you can reach most APIs through the MapGuide Enterprise
Web Server Extensions with Java, .NET, and PHP.
AutoCAD Map 3D ObjectARX API download contains FDO C# code that can be used in
either Map 3D or MapGuide.
Examples can be found in the C:\Map ObjectARX SDK 2010\Map Samples\Platform\
folder when the OjectARX API is installed.
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Chapter Summary
Having completed this chapter, you can:
■
■
■

Describe the key components of Autodesk MapGuide Enterprise.
Explain the four key processes to publish data to the web with Autodesk MapGuide Studio.
Explain Feature Data Objects (FDO) and its data providers.

Chapter Summary
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Chapter

2
Autodesk MapGuide Enterprise
Server
In this chapter, you explore the process of installing Autodesk MapGuide® Enterprise Server. Although
not officially supported to use as a Server, the installation that you use for the Windows version is
Microsoft Windows Vista.
The server‐side configuration of Autodesk MapGuide Enterprise, once installed and running, is
identical regardless of operating system used. You learn to install and configure Autodesk MapGuide
Enterprise Server and Web Server extensions on Microsoft® Windows® Vista.

Objectives
After completing this chapter, you will be able to:
■
■

Install MapGuide Server and Web Server Extensions.
Configure MapGuide Enterprise with the Site Administrator.

Chapter Overview
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Lesson: Installation
This lesson describes the processes for installing and configuring Autodesk MapGuide Enterprise. You
also install Autodesk MapGuide Enterprise Web Extensions.

Installing Web Server Extensions in Windows

Objectives
After completing this lesson, you will be able to:
Describe how to install MapGuide Enterprise on Linux.
Explain how to install MapGuide Enterprise on Windows.
Install MapGuide Enterprise in Windows.

■
■
■
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About Autodesk MapGuide Enterprise Server for Linux
Autodesk MapGuide Enterprise Server for Linux is available for those users who require a Linux server
rather than a Windows‐based server. There are some advantages to using Linux:
■
Thousands of programmers have reviewed the Open Source code to improve security and
performance, and to decrease bugs in the operating system.
■
Most Linux systems are based on standard PC hardware (i386 architecture), and Linux supports a
very wide range of PC and hand‐held devices.
■
Linux is extremely stable. Up‐times of a year or more are common.
■
Open source application software is readily available, including Apache Web server and the GIMP
graphics editor. Additionally, Linux is inexpensive.

Autodesk MapGuide Open Source
In this section, you learn to install the Autodesk MapGuide Server. Also, although you do not install the
MapGuide Open Source for Linux, the install procedure is reviewed. The primary difference between
the Autodesk MapGuide Open Source Server and the Autodesk MapGuide Enterprise Server lies with
the FDO Providers. Many direct FDO connections are available in the Autodesk MapGuide Open Source
Server edition, such as:
■
OSGeo FDO Provider for SQL Server Spatial
■
OSGeo FDO Provider for ArcSDE
■
OSGeo FDO Provider for SHP
■
OSGeo FDO Provider for MySQL
■
OSGeo FDO Provider for SDF
■
OSGeo FDO Provider for ODBC
■
OSGeo FDO Provider for WFS
■
OSGeo FDO Provider for WMS
■
OSGeo FDO Provider for GDAL
■
OSGeo FDO Provider for OGR
Although you use the Autodesk MapGuide Enterprise for Windows in this lesson, the Open Source FDO
providers are still installed in addition to the Autodesk FDO Providers (except for GDAL and OGR).

Autodesk MapGuide Enterprise
In addition to the Open Source FDO providers, with Autodesk MapGuide Enterprise you also receive
the following providers as part of the product:
■
Autodesk FDO Provider for Oracle (Spatial)
■
Autodesk FDO Provider for SQL Server
■
Autodesk FDO Provider for Raster (including MR SID, ECW and DEM)

Lesson: Installation
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System Requirements for Autodesk MapGuide Enterprise and MapGuide Open Source
Server for Linux
Autodesk MapGuide Enterprise and MapGuide Open Source Servers can run on Red Hat Enterprise
4.0 or Fedora Core 6. This lesson uses Fedora 6. The following are requirements for installing Autodesk
MapGuide Enterprise and MapGuide Open Source Servers:
■
Apache HTTP Server 2.xx
■
PHP 5.2.5
■
Java JDK 5.0
■
Feature Data Objects FDO 3.3
■
JPEG Library ‐ libjpeg.so
■
PNG Library ‐ libpng.so
The MapGuide Open Source LiveCD have MapGuide installed on Ubuntu on a
bootable CD.
Available at: mapguide.osgeo.org.

Apache, PHP and Tomcat
The Apache, PHP, and Tomcat requirements (APT) can be installed in one package and downloaded
from the http://mapguide.osgeo.org Autodesk MapGuide Open Source site.
This archived TAR file is called mapguideaptinstaller‐2.0.0.tar.gz.

Make sure you have met the Java requirement.

Java run time settings in Fedora
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Installing MapGuide Enterprise Server for Windows
Some preliminary setup steps are required before installing Autodesk MapGuide Enterprise Server.
If a previous version of the Autodesk FDO SDK, version 2.0 or less, has been installed, it needs to be
removed. The installation of Autodesk MapGuide Enterprise Server loads FDO 3.* automatically when
installing Autodesk MapGuide Enterprise for Windows.

FDO SDK
If already installed, the older FDO SDK 2.0 is located in the following folder:
C:\Program Files\Common Files\Autodesk Shared\GIS\FDO 2.0\
If this folder exists, it must be deleted or renamed prior to the installation of Autodesk MapGuide
Enterprise Server.

Web Server
Another prerequisite for the installation of Autodesk MapGuide Enterprise Server is a running Web
Server application. Most Microsoft Windows‐based servers use Microsoft Internet Information Server
(IIS) as the default web server, but it is not the only server available for Windows. Apache 2.0 or
greater is also supported by Autodesk MapGuide Enterprise on Windows or Linux.
If you choose a bundled install, Apache may be installed when the Web Extensions are installed.

PHP Version
PHP 5.2 or greater will be automatically installed when loading the Autodesk MapGuide Server Web
Extensions.
PHP 5.2 now has Object Oriented Programming (OOP) and XML extensions for manipulating and
working with XML files.

Install Autodesk MapGuide Enterprise Server
Once all the prerequisites are met, Autodesk MapGuide Enterprise Server can be installed. When
installing the server ensure that the site server is selected. The Autodesk MapGuide Enterprise Server
installation adds a Windows service.

Autodesk MapGuide Enterprise Server Service
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To ensure that the server is available and running, you can view the Services dialog box in Control
Panel.
Autodesk License Manager
When installing Autodesk MapGuide Enterprise, you must also install Autodesk
License Manger. When you register your Autodesk MapGuide Enterprise, the license
file (*.lic) that Autodesk sends must be read by the License Manger application called
LMTOOLS.

Install Autodesk MapGuide Enterprise Web Server Extensions
Once the server is installed, the next step is to install the Web Server Extensions. The Web Server
Extensions install the API tools that PHP, ASP.NET, or Java (JSP) languages can use to communicate
with the server.
Depending on the choice of PHP, Microsoft .NET, or Java, you must also configure the development
engine. For example, if the user chooses to install the .NET Web Server Extensions, the .NET
Framework must also be installed on the server. If the user chooses the Java Web Server Extensions,
then Apache Tomcat must also be installed.
Regardless of choice, PHP is a requirement for the installation of the Web Server Extensions as PHP is
used for the Autodesk MapGuide Enterprise Site Administrator.

Web Extensions Development Environment Choice

Next, the choice of Web Servers is shown. At this stage, IIS or Apache is available. If you select
Manually, you must create an alias called MapGuide on your Web server.

The Developer's Guide is stored in the C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions\Help\ folder.
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Exercise: Installing Autodesk MapGuide Enterprise Server
Exercise: and Web Extensions
In this exercise, you install Autodesk MapGuide
Enterprise Server and Web Extensions. The Autodesk
MapGuide Enterprise Web Extension will install
Apache web server with PHP support.

3.

4.

In the Install Wizard dialog box:
■
For Country, choose your country.
■
Click the I Accept.
■
Click Next.
For Install type:
■
Click Evaluation Installation.
■
Click Next.

The completed exercise

Install Autodesk MapGuide Enterprise Server
1.
2.

From the Autodesk MapGuide Enterprise
installation CD, start the Server installation.
Click Next on the first page.

5.

■

■

6.

Check the Site Server will be installed on
same machine as Web Server Extensions.
Click Next.

Click Install.
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7.

Click Finish to complete the installation.

2.

Click Next to start the installation.

3.

In the Web Server Extensions ‐ Install Wizard
dialog box:
■
For Country, click your country.
■
Click I Accept.
■
Click Next.
For Select Configuration Type:
■
Click Bundled Configuration.
■
Click Next.

Check Autodesk MapGuide Enterprise Server
Service
1.
2.

Open Control Panel > Administrative Tools >
Services.
Scroll down to view the MapGuide Enterprise
Server service and ensure that it is running.

4.

Install Autodesk MapGuide Web Server
Extensions
1.

From the Autodesk MapGuide Enterprise
installation CD, start the Web Extensions
installation.
NOTE: Apache Web Server and PHP will be
installed.
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5.

For Bundled Configuration Settings:
■
For Web Server Port Number, enter: 80
■
Click PHP.
■
Click Next.

6.

Under Server IP Address:
■
Ensure the Web Server Extensions Will Be
Installed On The Same Machine As The Site
Server is checked.
■
Click Next.

7.

For Setup Type:
■
Click Typical.
■
Click Next.

8.

For Ready to Install the Program:
■
Click Install.

9.

Click Finish to complete the Web Extensions
installation.

All of the Autodesk MapGuide Enterprise Server and
Web Extensions are now installed.

Check Autodesk MapGuide Enterprise Web
Extensions
1.
2.

Open Control Panel > Administrative Tools >
Services.
Scroll down to view the ApacheMapGuide2010
service and ensure that it is running.
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3.
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Open Internet Explorer.
■
In the Address Bar, enter: http://localhost/

■
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Lesson: Server Configuration
In this lesson, you utilize the Autodesk MapGuide Enterprise Site Administrator security and data
functions and explore some of the administrative features.

Making Package in MapGuide Site Administrator

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■

Describe the features of the MapGuide Site Administrator.
Create new user groups.
Create new users.
Assign roles to user groups.
Create an FDO alias.
Load a Package.
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About the Site Administrator
The Site Administrator enables the system administrator to:
■
Manage servers
■
Manage groups
■
Manage users
■
Assign roles
■
Load or create packages
■
Configure WMS
■
Configure WFS
■
Configure external files

Web‐based MapGuide Site Administrator
Administering a web‐based application such as Autodesk MapGuide Enterprise from the Web is the
most effective way of managing a web application. Even with the tools available to administrators
such as Microsoft Remote Desktop and Linux Terminal Services, the easiest method of managing the
server is, by far, with a web interface.

Autodesk MapGuide Enterprise Site Administrator login
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Manage Servers
Each Autodesk MapGuide Administrator Site can have any number of servers that support that site.
Each server is registered as such when installed. The Manage Servers area enables the administrator to
manage all servers within a site. Each server can be taken offline or online from this interface.

Autodesk MapGuide Site with Support Server

Log Files
Log files are extremely important for monitoring errors, users, and performance metrics. In MapGuide
Enterprise, server functions can be monitored and recorded with the log files including Access, Admin,
Authentication, Error, Session, and Trace.
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Manage Groups, Users, and Roles
There are three levels of security for each role:
■
User
■
Author
■
Administrator
Since the roles are applied to either the users or the groups of users, the security of the server is very
easy to manage. The User level of security is mainly for viewers of the map, whereas, the Author level
of security enables users or groups to manage the repositories and log in to the server with Autodesk
MapGuide Enterprise Studio. The most powerful role, the Administrator level of security, enables the
user or groups to use MapGuide Studio, and log in to the web‐based Site Administrator.
The Site Administrator is an independent security model and does not use the
security of Windows or Linux to control the Viewer, Author, or Administrator levels of
security.

Assign Roles within Site Administrator
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Manage Packages
Packages are used to increase the performance of moving large dataset's between servers and to
quickly set up data sets without having to reload them from within Autodesk MapGuide® Studio.
The MapGuide package is a zipped file (*.mgp) for bulk loading data onto the Autodesk MapGuide
Enterprise Server.
There is a folder on the Autodesk MapGuide Server that is configured to look for packages. If you copy
a package into that folder, the Site Administrator can also be used to load those files.
Packages can be created two ways:
■
From within Autodesk MapGuide Studio
■
From within the Site Manager
The default folder for packages in Windows is C:\Program Files\Autodesk
\MapGuideEnterprise2010\Server\Packages\ but this can be changed in the Manage
Servers area of the Site Administrator.

Create a package
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Configure WMS and WFS
The Open GIS Consortium (OGC) has developed standards for distributing GIS information. Using
the Web Map Service (WMS) and Web Feature Service (WFS), Autodesk MapGuide Enterprise can
distribute all mapping information to consumers of the WMS and WFS. WMS renders the mapping
information in an image file, such as PNG, so that the map information can be used in a browser.
Inquiry commands usually return an XML response that can be interpreted by an application.
Unlike WMS, WFS actually returns an XML response that sends the coordinate geometry and all the
feature information so that any client of the WFS can utilize the information to generate live vector
information.
The fact that Autodesk MapGuide Enterprise can distribute its GIS information using WMS (raster) or
WFS (vector) formats makes it extremely flexible and powerful. All settings for the WMS and WFS are
configured in the Site Administrator.

Autodesk MapGuide Enterprise is OGC compliant for WMS

Configure External Files
With Autodesk MapGuide Enterprise you can connect directly to any file‐based data that is accessible
by the server machine without using Autodesk MapGuide Studio. The file‐based data can reside in any
directory on the server or on the network. This data can be accessed by Autodesk MapGuide Studio
and resides outside of the server's data repository.
Aliases are created in the Site Administrator in order to point to the directory that contains the data
(SHP, SDF 3.* and Raster files).These aliases are used in Autodesk MapGuide Studio when you create
layers.

Alias Creation in Site Administrator
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Exercise: Create New User Groups
In this exercise, you create three new user groups
in Autodesk MapGuide Enterprise Server Site
Administrator.

4.

Under Add Group:
■
In the Group Name text box, enter:
MapViewers
■
In the Description text box, enter: Internet
Map Viewers
■
Click Save.

5.
6.

Under Manage Groups, click Add Group.
Under Add Group:
■
In the Group Name text box, enter:
MapAuthors
■
In the Description text box, enter: Studio
Authors
■
Click Save.

7.

Under Mange Groups, click Add Group.

The completed exercise

Create New User Groups
1.

2.

3.

Open Internet Explorer and enter the following
URL in the Address bar: http://localhost/
MapGuide2010/mapadmin/login.php
In the browser:
■
For the Administrator ID, enter:
Administrator
■
For the Password, enter: admin
■
Click Login.

Under Manage Groups, click Add Group.
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8.

Under Add Group:
■
In the Group Name text box, enter:
MapAdministrators
■
In the Description text box, enter:
Administrators
■
Click Save.

9.

Note the three new groups under Manage
Groups.
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Exercise: Create New Users
In this exercise, you will create three new user users
and add them to associated groups.

2.

Under Add User:
■
For the User ID enter: Viewer1
■
For the User Name enter: Viewer1
■
Leave the Description blank.
■
For the Password enter: Viewer1
■
For the Confirm Password enter: Viewer1.

3.

Under Member Of:
■
In Available Groups, click MapViewers.
■
Click Add.

4.

Click Save.

The completed exercise

Log in to Site Administrator
1.

2.

If you have not already logged into Autodesk
MapGuide SIte Administrator, open Internet
Explorer and enter the following URL in the
Address bar: http://localhost/MapGuide2010/
mapadmin/login.php
Under Login:
■
For the Administrator ID, enter:
Administrator
■
For the Password, enter: admin
■
Click Login.

Create Viewer1 User
1.

Under Manage Users, click Add User.
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2.

Under Add User:
■
For the User ID enter: Admin1
■
For the User Name enter: Admin1
■
Leave the Description blank.
■
For the Password enter: Admin1
■
For the Confirm Password enter: Admin1

3.

Under Member Of:
■
In Available Groups, click
MapAdministrators.
■
Click Add.

4.

Click Save.

Create Author1 User
1.
2.

3.

4.

Under Manage Users, click Add User.
Under Add User:
■
For the User ID enter: Author1
■
For the User Name enter: Author1
■
Leave the Description blank.
■
For the Password enter: Author1
■
For the Confirm Password enter: Author1

Under Member Of:
■
In Available Groups, click MapAuthors.
■
Click Add.

Click Save.

Create Admin1 User
1.
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Under Manage Users, click Add User.
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Exercise: Assign Roles
In this exercise, Administrator and Author roles will be
assigned to existing groups.

2.

Under Login:
■
For the Administrator ID, enter:
Administrator
■
For the Password, enter: admin
■
Click Login.

Assign Roles
The completed exercise

Log in to Site Administrator
1.

If you have not already logged into Autodesk
MapGuide SIte Administrator, open Internet
Explorer and enter the following URL in the
Address bar: http://localhost/MapGuide2010/
mapadmin/login.php

1.
2.
3.
4.

Click Assign Roles.
Click the Groups tab.
For the MapAdministrators group, check the
Administrator role and the Map Author role.
For the MapAuthors group, check the Map
Author role.
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5.

Leave the defaults for the MapViewers group.

6.

Click Save.
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Exercise: Create Alias
In this exercise, you will create a new alias and will
connect to a directory containing SHP files.

Create Alias
1.
2.
3.

Click Configure External Files.
Click Add Alias.
Under Add Alias:
■
For the Alias name, enter: EXTERNAL_SHP
■
For Path to External Folder, enter: C:
\Projects\MapGuide2010\SHP\

4.

Click Save.

The completed exercise

Log in to Site Administrator
1.

2.

If you have not already logged into Autodesk
MapGuide SIte Administrator, open Internet
Explorer and enter the following URL in the
Address bar: http://localhost/MapGuide2010/
mapadmin/login.php
Under Login:
■
For the Administrator ID, enter:
Administrator
■
For the Password, enter: admin
■
Click Login.
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Exercise: Load a Package
In this exercise, you use the Site Administrator to
load a MapGuide Package (*.mgp) file that contains
data that was previously exported using Autodesk
MapGuide Enterprise Server.

The completed exercise

Copy Package
1.
2.

3.
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Using Windows Explorer, browse to the C:
\Projects\MapGuide2010\Packages\ folder.
In a new Windows Explorer window,
browse to the C:\Program Files\Autodesk
\MapGuideEnterprise2010\Server\Packages\
folder.
Copy the Sheboygan.mgp file into
the C:\Program Files\Autodesk
\MapGuideEnterprise2010\Server\Packages\
folder.

■

Log in to Site Administrator
1.

2.

If you have not already logged into Autodesk
MapGuide SIte Administrator, open Internet
Explorer and enter the following URL in the
Address bar: http://localhost/MapGuide2010/
mapadmin/login.php
Under Login:
■
For the Administrator ID, enter:
Administrator
■
For the Password, enter: admin
■
Click Login.
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4.

To ensure that Package was loaded properly,
under Status check that the window states
LOAD SUCCEEDED.

5.

Close the MapGuide Site Administrator.

Load Package
This exercise loads the Package (MGP) file that is
stored on the server. The MGP file contains SDF files
and associated layers, maps and layouts.
1.
2.

3.

In MapGuide Site Administrator, click Manage
Packages.
Under Load Package:
■
Ensue Sheboygan.mgp is selected.
■
Click Load Package.

In the Internet Explorer dialog box, click OK.
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Chapter Summary
Having completed this chapter, you can:
Install MapGuide Server and Web Server Extensions.
Configure MapGuide Enterprise with the Site Administrator.

■
■
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Chapter

3
Authoring with Autodesk
MapGuide Studio
In this chapter, you get an in‐depth look at Autodesk MapGuide® Studio, an authoring environment
that handles most aspects of collecting and preparing geospatial data for distribution on the Internet.
MapGuide Studio follows four steps to get information to the Web: Create resources from your source
data, build styled and themed layers from the resources, compile the layers into a map, and finally,
embed the map in a web page using a web layout.
The final step, creating a web layout, is not covered in this chapter.

Objectives
After completing this chapter, you will be able to:
■
■
■
■

Explain the difference between data loading and data connections within MapGuide Studio.
Describe the data loading process in MapGuide Studio.
Create layers in MapGuide Studio.
Create maps in MapGuide Studio.
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Lesson: Data Connections
In this lesson, you explore the difference between loading data and connecting with an alias. Before
you can build maps in Autodesk MapGuide® Enterprise Server, you must make your source data
available. There are two ways to make source data available, depending on the format:
■
Load any file‐based data such as DWG™, SHP, SDF, and raster files.
■
Configure connections to databases such as Oracle, ArcSDE, or MySQL or external files such as
SHP, SDF, and raster with aliases.

Preview of the data source in MapGuide Studio

Objectives
After completing this lesson, you will be able to:
Decide which type of data connection to make.
List the types of FDO providers.
Describe how to use unmanaged data sources.
Explain how to use the data source preview tool.
Create folders in MapGuide Studio.
Connect MapGuide Studio to Microsoft Access.
Connect to a FDO aliased SHP folder.

■
■
■
■
■
■
■
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About Data Management
You can load data by converting all, or part of, the source file into a format that Autodesk MapGuide
Enterprise Server can use (for example SDF, SHP, or DWF™) and store it as a resource. For example, you
can automatically load all the layers in a DWG file and create a separate SDF resource for each one.
Data stored in a database does not need to be loaded. You simply connect to it by configuring a
data source for it. In this case, the information necessary to connect to the database is stored as the
resource.
Autodesk MapGuide Enterprise Server uses Autodesk Feature Data Objects (FDO) to make database
connections. An Autodesk FDO provider is an implementation of the FDO API that provides access to
data in a particular DataStore. The resource repository is an XML database that stores the resources
created by loading file‐based data or by connecting to databases. There is one repository per site and
it resides on the site server.
Resources are designed to be reused and shared. Some resources reference other resources. For
example, maps and layers are stored as separate resources, and the map references the layers that
are included in the map. Layers reference feature sources or drawing sources. When you update the
original feature source, the layer is automatically updated as well.

Resources
Some resources stored on the MapGuide Server, such as print layouts, are self‐sufficient and do not
reference any other resources or files. Some resources use associated resource data. For example, an
ArcSDE feature source uses a file that holds the database credentials. Resource data can be stored as
files, streams, or strings.
■
Files are used when the amount of data is large, such as DWF or SDF files.
■
Streams are used for faster access to smaller pieces of binary data, such as symbols.
■
Strings are used for small pieces of text data, such as database access credentials or aliases.

General Process
Regardless of whether the data you are using is file‐based, such as SDF or SHP files, or contained
in a database, such as Oracle or MySQL, the following steps are always the same within Autodesk
MapGuide Studio:
■
Find data.
■
Make layers.
■
Build a map.
■
Place the map on the Internet.
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Connecting with FDO Data Sources
FDO Connections
Connections to databases are stored as resources in the resource repository and can be edited just
like any other resource. Connection resources use one of the following providers:
■
Autodesk FDO Provider for Oracle
■
Autodesk FDO Provider for SQL Server
■
Autodesk FDO Provider for Raster
■
OSGeo FDO Provider for ODBC
■
OSGeo FDO Provider for SDF
■
OSGeo FDO Provider for SHP
■
OSGeo FDO Provider for MySQL
■
OSGeo FDO Provider for ArcSDE
■
OSGeo FDO Provider for SQL Server Spatial
■
OSGeo FDO Provider for WMS
■
OSGeo FDO Provider for WFS
Some FDO Providers require that the associated client software be installed. For
example, the Oracle Client is required to connect to an Oracle database.
Data connections using FDO providers give Autodesk MapGuide Enterprise the ability to render data
in "real time" from live GIS databases or repositories. Each FDO provider can access the data features
in the same way.
Once the vector features are returned to the Autodesk MapGuide Studio, every feature is treated the
same way and can be authored as a point, polygon, or polyline feature, regardless of the original data
source.
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About Unmanaged Data Sources
With Autodesk MapGuide Enterprise you can connect directly to any file‐based data that is accessible
by the server machine without the need for a load procedure in Autodesk MapGuide Studio. The file‐
based data can reside in any directory on the server or network.
These unmanaged data sources are linked with an alias pointing to the folder on the server that
contains the files. You create these aliases with the Autodesk MapGuide Enterprise Site Administrator.

Example
Suppose Road.shp resides in a folder named h:/datafiles/shp/. To create a road feature source in
MapGuide Studio to connect directly to Road.shp on the H drive, you create an alias called CITY_SHP in
the Site Administrator to point to this directory.

Example of FDO folder alias in MapGuide Studio

Benefits of Using Aliases and Unmanaged Data Sources
Uploading source data files to the resource repository using load procedures can be problematic and
time consuming, especially with large files. In addition, using a load procedure to make a copy of
the data resources causes file duplication. Access to unmanaged data sources resolves the problems
associated with moving large data files as well as the need to maintain and store duplicate data files.
This way, real‐time updates of data are possible without resorting to automating load procedures.
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Using Data Source Preview
Knowing the contents of a data source such as the schema, row types, and geometry information, is
extremely useful when creating a MapGuide application. In MapGuide Studio, information about a
feature source, such as the schema, feature classes, and geometry can be displayed both in tabular
and in graphical form.

Data Source Preview Definition
A Data Source Preview in MapGuide Studio displays tabular and graphical information of a data
resource. Tables are used to show property data and geometric property information of a selected
schema and its associated feature classes. Navigation tools are provided to view all the available
information.
In loading a large set of data, the table has a maximum number of entries defined to
prevent poor performance and time lagging.
A graphical display shows the geometry preview of a feature source. Tools like zoom‐in, zoom‐
out ,and pan are included for basic navigation. The default background color of the map is beige and
each geometry type is displayed in a default color. Surface geometries are displayed in orange, line
geometries in blue, and point geometries in red.
A warning is displayed when you request a preview of a feature source that contains
more features than the maximum value. Authors have the choice to cancel or to
continue displaying the preview.

Point geometry preview
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An Example
After adding Parcels.sdf data source in MapGuide Studio, the author can simply click the preview
button to see a graphical preview of Parcels.sdf.

Benefits of Using Data Source Preview
It is very difficult to know the full contents of a particular data resource simply by the file name.
Autodesk MapGuide Enterprise solves this problem by displaying a tabular and a graphical preview of
the data resource in the feature source editor.
The Data Source Preview allows the author to become familiar with the contents of the data resource
at the time the resource is loaded. As a result, authors can better plan each map layer which, in turn,
results in more efficient map creation.

Previewing the Tabular Contents of a Data Source
To preview the tabular contents of a data source, follow these steps:
1.
2.
3.
4.

Log in to Autodesk MapGuide Enterprise Studio.
In the Feature Source Editor, open any feature source you want to preview.
Look over the Data Properties and Geometric Properties available in the Preview pane.
Click the View Data button to see the tabular contents of the data source.

5.

Use the navigation tools available to view all the information available.
Click the Refresh button to load the tabular and graphical contents of the selected
feature source. If a “Session Expired” notification appears, click Refresh. Session time
outs can be specified in the webconfig.ini file or by modifying the Web Server settings
in IIS or Apache.
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About Feature Joins
Use joins to add extra data to GIS features in your map. You can join data from the any of your vector‐
based FDO data sources.
After you create the join, you can use the additional properties the same way you use the native
properties of the features: to label, theme, style, and analyze the layer's features. With joins, you can
keep your data in separate tables, focused on specific topics, instead of in one large database or file.
This can ease administration and reduce complexity. Typically, a join connects a separate table of data
(a secondary table) to a feature class layer (the primary table).

Feature Join in MapGuide Studio

About Join Types
There are two types of joins: Left Outer Joins and Inner Joins.
The Left Outer Join keeps all the features of the original feature source (the Left table) even if the
joining feature (the Right table) does not match. This type of join will ensure that all the features
appear on the map regardless of matching records in the joined feature.
The Inner Join filters the original feature based on those records that match the columns in the joining
feature. This type of join is very effective in validating if the records exist in the joined table as only
those matching records will appear on the map.

Types of Joins
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Relationship with Secondary Records
Cardinality (relationship with secondary records) refers to the uniqueness of the data records that are
connected in the join. There are two types of relationships: one‐to‐one and one‐to‐many.
One‐to‐one joins connect the features from the left with the right and return the first matching record
in the right table. This type of join is simplest and returns a single feature per record.
One‐to‐many joins redraw the same left feature as many times as there are matches in the right
table. This type of join duplicates features on the left so that all the matching records on the right are
accounted for.

Relationship with Secondary Records

Example of Feature Joins
An example of a feature join is illustrated by joining a SHP file containing parcels to an SQL Server
database that contains zoning information. The SHP file is connected to the SQL Server through an
ODBC connection. The Parcels.shp file is the left feature and the SQL Server is the right feature.
By joining the parcels to the zoning table, the user has access to the zoning designation for theming,
labeling, or tooltips.

Shape file and SQL Server Join
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Exercise: Using Studio to Create Project Folders
In this exercise, you create a series of folders within
Autodesk MapGuide Studio.

2.

The completed exercise

Create a Data Connection
1.

3.

Open Autodesk MapGuide Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

4.
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In the Site Explorer:
■
Expand the Sheboygan folder.
■
Expand the various sub‐folders.

This data was loaded by Loading a Package in
the Server Configuration lesson.
In Site Explorer, right‐click over http://
localhost/mapguide2010.
■
Click New > Folder.

For the name of the new folder, enter:
REDDING
Note: case sensitivity is very important so
make sure all your folders are in uppercase.
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5.

Under the new REDDING folder, create 7 new
folders called:
■
1_LOAD_PROCEDURES
■
2_DATA
■
3_LAYERS
■
4_SYMBOLS
■
5_MAPS
■
6_SIMPLE_LAYOUTS
■
7_FLEXIBLE_LAYOUTS
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Exercise: Creating a Data Connection to a Microsoft Access
Exercise: Database
In this exercise, you create a data connection to a
Microsoft Access database in Autodesk MapGuide
Studio.

2.

In the Site Explorer:
■
Under REDDING, right‐click the 2_DATA
folder.
■
Click New > Data Connection.

3.

In the Connect to Data dialog box:
■
Select OSGeo FDO Provider for ODBC.
■
Click OK.

The completed exercise

Create a Data Connection
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

■
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4.

5.

6.
7.

8.
9.

In the Edit pane, a New Feature Source tab is
displayed.

To view the Editor only, click the Edit button.
Under Configure ODBC Connection:
■
For Type of Connection, select Connect to
a File and Upload to MapGuide Library.

Under Data File and Any Associated Files to Be
Uploaded, click New.
In the Select Data Files dialog box:
■
Browse to the C:\Projects
\MapGuide2010\Database\
file.Autodesk_Redding_Dataset.mdb file.
■
Click Open.
Click File menu > Save.
In the Save Resource As dialog box:
■
Browse to the library://REDDING/2_DATA/
folder.
■
For the resource name, enter:
REDDING_MSACCESS
■
Click Save.

10. In the Editor pane, under Define Geometry
Properties to Create Spatial Feature Classes
(optional), click Show Tables.

11. Check the Geometry for the MaintenanceHole
table.
■
For the X Column, select LON.
■
For the Y Column, select LAT.
■
Leave the Z column blank.

12. Under Coordinate System, click the Browse
button.
■
In the Coordinate System dialog box, under
Categories, select Lat Longs.
■
Under Available Coordinate Systems, select
LL27.

■

Click OK.

13. Click Save.
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14. At the top of Autodesk MapGuide Studio, click
Preview.
15. In the Preview Pane:
■
Under Class MaintenanceHole, click View
Feature.
■
In the Internet Explorer dialog box, click
OK.
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Exercise: Creating a Data Connection to a SHP Folder
In this exercise, you create a data connection to a
SHP folder that was previously aliased with Autodesk
MapGuide Enterprise Site Administrator.

2.

3.

In the Site Explorer, under REDDING, right‐click
the 2_DATA folder.
■
Click New > Data Connection.
In the Connect to Data dialog box:
■
Click OSGeo FDO Provider for SHP.
■
Click OK.

The completed exercise

Create a Data Connection with SHP Alias
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

4.

In the Edit pane, a New Feature Source tab is
displayed.
■
Under File or Folder to Connect To, click the
Folder button.
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5.

In the Select an External Folder Alias dialog
box:
■
Click EXTERNAL_SHP.
■
Click OK.

6.
7.

Click File menu > Save.
In the Save Resource As dialog box:
■
Browse to the Library://REDDING/2_DATA/
folder.
■
For Resource Name, enter: REDDING_SHP
■
Click Save.
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Exercise: Creating a Join between SHP and ODBC Database
In this exercise, you connect a SHP file to an ODBC
Microsoft Access database. By creating a JOIN, the
data stored in the database is then available within
Studio for theming or labeling the SHP file.

2.

In Site Explorer:
■
Under REDDING > 2_DATA, right‐click
REDDING_SHP.
■
Select Open.

3.

Under Add Properties to Classes Using Joins
and Calculations, click New > Join.

4.

For Name of this Extended Feature Class,
enter: Hydrant_Join

The completed exercise

Creating a Join between SHP and ODBC
Database
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

Lesson: Data Connections

■

67

5.

Under Add Properties to Classes Using Joins
and Calculations (Optional):
■
Click New Join.

6.

Under Set Up the Join:
■
For Secondary Source, click Browse.

8.

Under Set Up the Join:
■
For Secondary Class (table), choose:
Default: Hydrant_Maintenance
■
For Name of this Secondary Join, enter:
Hydrant_Maintenance_Join
■
For Match this Column with Table on the
Left, choose: HYD_NO

■

7.

In the Open Resource dialog box:
■
Click REDDING_MSACCESS.
■
Click Open.

9.

For With this Column from Secondary Class
"Hydrant_Maintenance", choose HYD_NO*

For Type of Join:
■
Click Keep All Records on the Left.
■
For Relationship with Secondary Records
(Cardinality), click One‐to‐Many.

10. Click Save.
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Lesson: Data Loading
In this lesson you use Autodesk MapGuide Studio to load data onto the MapGuide Server. When you
drag a file or a set of files of the same format to the Site Explorer in Autodesk MapGuide Studio, you
start a new load procedure. Load procedures are saved scripts for reloading data used to automate the
updating of resources on the server. They capture the location of the source files, the conversion rules,
and where to put the resulting data on the server.
You can execute these conversion rules (either interactively in Autodesk MapGuide Studio or through a
script) to refresh file‐based spatial data on your site. Scripts can be run overnight or at regular intervals
to keep the data current.
Load procedures are stored as resources in the repository. Open them in Autodesk MapGuide
Studio whenever you need to add or delete files, change the destination, or update any of the other
parameters.

Example of load procedure for SDF

Objectives
After completing this lesson, you will be able to:
■
■
■
■

Describe the MapGuide Studio load procedure.
Explain how to load raster data.
Load SHP files with a Load Procedure.
Load Raster Files with a load procedure.
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About Data Loading
Transforming Data
Some types of files can be transformed rather than directly loaded. Transforming a data file includes
converting the file to another format during the load procedure. If you were to upload a SHP file, you
have a choice to use the native SHP format or to convert it to SDF (a file‐based personal geodatabase).
These file formats can be transformed into SDF or DWF:
■
SHP
■
DWG
■
DXF™
■
SDF 2.0

Loading Data
Unlike direct FDO data connections, loading data requires that the data files be uploaded to the server
from Autodesk MapGuide Studio. The data is updated each time the load procedure is run.
These file types can be loaded directly, without translation or transformation, into the Autodesk
MapGuide Enterprise Server library with Studio:
■
Autodesk DWF
■
Autodesk SDF 3.*
■
SHP
■
Raster formats: BMP, PNG, JPG/JPEG, TIF/TIFF, TGA, CAL, ECW, SID (MR SID)

About DWG and DXF Files
DWG and DXF files are treated differently than other files that are loaded with MapGuide Studio.
Since DWG and DXF files may already have stylization applied such as layer color or blocks, you may
want to keep the visual aspect of the file intact. To keep the file intact, transform the DWG or DXF into
a DWF when loading the files. The drawing source or DWF is virtually identical to the DWG.
However, the DWG can be extracted into individual SDF files, or one SDF file. The SDF feature source
can then be themed or stylized using Autodesk MapGuide Studio tools.
You can extract features based on:
■
AutoCAD® layer
■
AutoCAD® Map 3D queries
■
AutoCAD Map 3D themes
■
Display Manager AutoCAD Map 3D maps
The DWG file must have saved queries, themes, or display manager maps available
to filter based on those settings. Also, if you want to retain Object Data, Link
Templates, or Block Attributes, you must have already classified the DWG.
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Drawing sources (DWF) or feature sources (SDF) are chosen based on whether the drawing is already
stylized or will be stylized later in Autodesk MapGuide Studio. For example, if the DWG file already has
all the water pipes on a blue layer, but you want to color code the pipe based on age, then a feature
source transformation into an SDF and connected to a data source is best.

Transforming resource types

Often, closed polylines are treated as polygons within AutoCAD Map 3D. If you would like to ensure
that all the closed polylines are polygons when transforming the DWG or DXF, you must select the
Transform Closed Polylines into Polygons check box.

If Drawing Source is selected, no theming or stylizing of the data is possible beyond
what was already contained in the DWG or DXF file.
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Loading Raster Data
Raster (or image) files are pixel‐based data, such as digital photographs, that you can use as
backgrounds for feature and drawing data. For example, you can display an aerial photograph of a city
under a layer of streets.
An individual image file must be geo‐referenced. Geo‐referenced files usually have an associated file
(for example, TFW for TIFF files) that specifies the location of the image within the coordinate system
used in the map. You can use products such as AutoCAD® Raster Design to geo‐reference images.
TIFF and MrSID files are loaded without conversion. All other formats are converted to TIFF during the
load process.

Raster data in MapGuide Studio
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Raster Catalogs
Raster files are cataloged to optimize performance. You create a raster catalog as part of the load
process. A raster catalog file (known as RIC files in legacy MapGuide 6.x applications) contains a list of
image files and their lower‐left and upper‐right coordinates. When you access a layer that references
a raster catalog, the server scans the catalog file to find the images that correspond to the area being
viewed, and then sends only the data for that area.

Raster catalog

When you sub‐sample the files referenced by a raster catalog, you reduce their resolution by a
specified factor. This makes the files smaller and faster to access, and is particularly useful when the
user is zoomed out to view a large area and high resolution is not needed.

Sub‐Sample Raster Images
When you sub‐sample the images, you should not overwrite the original images. Instead, you save
the sub‐sampled images to a new directory as TIFF image files. In the process you create a new raster
catalog that references the sub‐sampled images. This ensures that your original images and raster
catalog remain unchanged. For example, you could use the original layer with the raster catalog when
the user is zoomed in to an area, but use the new raster catalog with the sub‐sampled images when
the user zooms out and does not need the higher resolution.

Sub‐sample the raster files

Each time the raster images are updated, you can use the saved load procedure in Autodesk MapGuide
Studio to refresh the images on the server. Simply open the saved load procedure and click Load
Resources to trigger an update of the raster images.
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Exercise: Load SHP Files with a Load Procedure
In this exercise, you use a Load Procedure to load a
several Shape files containing Parcels, Roads, Valves,
Waterlines and Zoning. The Load Procedure will
convert these Shape files into SDF files and upload
them to the server.

2.

In the Site Explorer:
■
Under REDDING, right‐click the
1_LOAD_PROCEDURES folder.
■
Click New > Load Procedure.

3.

In the Select Files to Load dialog box:
■
Browse to the C:\Projects
\MapGuide2010\Source\ folder.
■
Select all of the shape files in the folder.
■
Click Open.

The completed exercise

Load SHP Files with Load Procedure
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

■
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4.

In the New Load Procedure tab:
Under How Do You Want to Transform the
Data, beside For the SHPs with No Coordinate
System Use, click Browse.

5.

In the Coordinate System dialog box:
■
Under Categories, select USA, California.
■
For Available coordinate systems, select
CA‐I NAD27 California State Planes, Zone
I(401), US Foot.
■
Click OK.

9.

In the Browse for Folder dialog box:
■
Click REDDING.
■
Click OK.

10. In the Save the Resource area:
■
Under In this Folder, enter: 2_DATA
■
For the Layer(s), under In this Folder, enter:
3_LAYERS

6.
7.
8.

Leave the Generalize Data by this Percentage
at 100%.
Ensure that Convert to SDF Feature Source is
checked.
Under Where Do You Want to Load the
Resources?, for the Destination Folder, click
Browse.

Note: The folder names are case‐sensitive.
11. Click File menu > Save.
12. In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/1_LOAD_PROCEDURES/ folder.
■
For Resource Name, enter:
REDDING_LOAD_SHP
■
Click Save.
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13. In the REDDING_LOAD_SHP Edit pane, click
Load Resources.

The SHP files are converted to SDF and
uploaded to the server.
14. Browse the Site Explorer:
■
Expand the 2_DATA folder to view the new
data files.
■
Expand the 3_LAYERS folder to view the
new layers.
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Exercise: Load Raster Files with a Load Procedure
In this exercise, you load two MR SID raster files into
MapGuide.

2.

In the Site Explorer:
■
Under REDDING, right‐click the
1_LOAD_PROCEDURES folder.
■
Click New > Load Procedure.

3.

In the Select Files to Load dialog box:
■
Browse to the C:\Projects
\MapGuide2010\Raster\SID\ folder.
■
Select all of the MR SID files in the folder.
■
Click Open.

4.

Under 2. How Do You Want To Transform The
Tiled Images:
■
For Coordinate System, click Browse.

The completed exercise

Load Raster Files with a Load Procedure
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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5.

6.

7.
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In the Coordinate System dialog box:
■
Under Categories, select USA, California.
■
For Available coordinate systems, select
CA‐I NAD27 California State Planes, Zone
I(401), US Foot.
■
Click OK.

Under 3. Where Do You Want to Load the
Resources:
■
For the Destination Folder, click Browse.
In the Browse for Folder dialog box:
■
Click REDDING.
■
Click OK.

■

8.

In the Save the Resource area:
■
Under In this Folder, enter: 2_DATA
■
Uncheck the Layer(s).

9.

For Raster Catalog Resource Name, enter:
REDDING_RASTER

10. Click File menu > Save.
11. In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/1_LOAD_PROCEDURES/ folder.
■
For Resource Name, enter:
REDDING_LOAD_RASTER
■
Click Save.
12. In the REDDING_LOAD_RASTER edit pane, click
Load Resources.
13. Browse the Site Explorer to view the new
Raster data in the 2_DATA folder.
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Lesson: Layers
In this lesson, you learn how to modify and stylize layers. Each layer, regardless of type, drawing
source, feature source, or raster data, can be stylized in some way.

Layer Preview in MapGuide Studio

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■
■

Describe how to stylize feature source based layers.
Explain how to create custom line and symbol styles.
Describe the advanced stylization techniques for labels, themes, and raster layers.
Create a new database‐driven point layer.
Create a layer that is thematically styled.
Create a simple polyline layer.
Create an Airphoto layer.
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About Layers
Introduction to Vector‐Based Sources for Layers
During the load process, Autodesk MapGuide Studio transforms vector‐based source data into
formats that are optimal for serving over the Web. Some formats, including Autodesk SDF and
Autodesk DWF, are already optimal for use on the Web. These formats are loaded directly without
transformation. Other formats are converted into either SDF or DWF, which are the two native file
formats in Autodesk MapGuide Enterprise Server. SDF is used for feature sources and DWF is used for
drawing sources.
■
Feature sources (such as SDF or Oracle Spatial) are the best choice when you simply want to load
the raw geometry and then style or theme it in Autodesk MapGuide Studio.
■
Drawing sources (such as DWF) are best when you want to retain any styles or themes already
applied to the source data.

Feature Sources
The settings area of the Layer Editor window contains the definitions of the layer and its attributes.
For example, the layer may contain parcels and its properties such as area, ownership, and zoning
classification.
For feature source‐based layers, such as SHP, Oracle spatial, or SDF, you can expose these properties
in the viewer. For feature source layers, you can apply a logical filter to the layer as well. For example,
the layer can show only those water main features whose diameter is > 10 inches.
The map author can define a URL to display when a user clicks a feature on this layer based on the
feature attributes, including a concatenation of the properties
For example: CONCAT (“http://www.autodesk.com/report.aspx?water_key= “, MAIN_ID)

Appling a filter to a feature source

Also, a tool‐tip that is displayed when the pointer pauses on a feature on this layer can be defined
based on the properties as well.

Feature Sources ‐ Styles
For all the feature sources, the Styles area has three settings for every scale range:
■
Style of the geometry
■
Feature label
■
Theme
The style of the geometry interface will change based on the type of geometry, point, line, or polygon.
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Scale Ranges
A scale range specifies the zoom level at which a particular style is applied to the display of your data.
When the zoom level of Autodesk MapGuide Studio or the Viewer is within the specified scale range,
the layer is redrawn as specified by the style associated with the scale range.
The style is applied when the zoom level is greater than or equal to the From value and less than the
To value. When setting up adjacent scale ranges, use the same To value as the next range's From value.
For example, if one range is 0 ‐ 20,000, set the next range to 20,000 ‐ 40,000.
Scale ranges are available to all layers regardless if drawing source, feature source, or raster is used.

Area Style
You can change two items when styling polygons: fill settings and border line settings.

Area Style dialog box
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Line Style
Lines have two settings, either a single line or a composite line made of two or more lines viewed on
top of one another. These lines can become very complex, such as a line with a dashed line on top to
provide the illusion of a painted line in the middle of a road.

Line Style dialog box
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Point Style
You can show points by using Autodesk MapGuide Studio default symbols. If you want to use a custom
symbol, you can load one into the symbol library.
Symbol library resources contain one or more symbols that can be used when applying styles to points
or labels. Autodesk MapGuide Studio supports numerous file formats including:
■
Bitmap (BMP)
■
Device Independent Bitmap (DIB)
■
Enhanced Metafile (EMF)
■
TrueType Fonts (TTF)
■
Windows Metafile (WMF)
■
Portable Network Graphics (PNG)
■
Joint Photographic Experts Group (JPG/JPEG)

Symbol Library containing imported DWG blocks

If AutoCAD blocks are to be used with Autodesk MapGuide Studio they must be
converted into a symbol library‐compatible format such as EMF or PNG. You can load
blocks into the symbol library by loading the DWG into Studio using a load procedure
as long as the blocks are used in the DWG.
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User‐Defined Line Styles and Symbols
Autodesk MapGuide Enterprise uses a cartographic styling engine to create sophisticated line styles
and symbols. The styling engine also supports point symbols as labels.
In addition, you can create symbols that adhere to the FGDC Digital Cartographic Standard for
Geologic Map Symbolization.

Definition of User‐Defined Line Styles and Symbols
User‐defined line styles and symbols are graphical representations used to extend the visual
representation of linear and point features to comply with local standards.

Custom symbol XML in Autodesk MapGuide Studio
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Examples
Line style with simple dashing used to represent a roads centerline. The repeating dash pattern is “long
dash / dot / short dash / dot”
The following are examples of user‐defined line styles:

Gas Line Example
Line style with start / end symbols used to represent a gas line. This line style includes text along the
centerline with start and end symbols.

Highway Shield Example
Interstate highway symbol with label
The following is an example of user‐defined point symbol:
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Benefits of User Defined Line Styles and Symbols
In many countries, publicly published maps must adhere to symbolization standards that are
even sometimes written into law. In addition, many geospatial applications require sophisticated
symbolization. With the power of the new cartographic styling engine in MapGuide Enterprise, you
can create sophisticated line stylization and point symbols to meet these demanding and diverse
requirements.

Process: Creating a User‐Defined Symbol
To create a user‐defined symbol, follow these steps:
1.
2.

3.

In MapGuide Studio, click New>Symbol Definition.
The Symbol Definition Editor opens with a definition template. Use the template to create the XML to
define the symbol. Review SymbolDefinition‐1.0.0.xsd located at www.osgeo.org for the symbolization
schema.
In MapGuide Studio, click File>Save to save the symbol definition. Symbol definitions are saved as a
new resource type, and are stored in the Resource Repository.

Process: Using a User‐Defined Symbol
To utilize a user‐defined symbol, follow these steps:
1.
2.

3.

4.
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In MapGuide Studio, once your custom symbol is created, export the layer you want to modify as an
XML file. Use File menu > Save As XML.
Using a text editor, modify the LayerDefinition.xml file and replace the default symbolization to point
to the newly saved Symbol.
For example, for a Line feature, replace the <LineTypeSyle> with <CompositeTypeStyle>:

Load this modified LayerDefinition.xml into MapGuide Enterprise using the mapagent tools found at:
http://localhost/mapguide2010/mapagent/index.html
Using the SetResoure link, browse to the modified LayerDefinition.xml file and ensure the Resource ID
is correct. For example: Library://REDDING/3_LAYERS/Roads.LayerDefinition
Open MapGuide Studio and view the modified layer.
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Advanced Stylization
Any feature source data can use its properties or an expression to generate labels on each object for
every scale range. For example, a road can be labeled by its associated street name column when the
map is zoomed into 1:10,000 or closer.
Any font that is installed can be used, but it also must be installed on the Autodesk
MapGuide Enterprise Server to render with the HTML Viewer. If you use the DWF
Viewer, the client must also have the fonts installed unless you convert the font to
Raster in the symbol library.

Load Fonts into MapGuide

Theme
Themes are styles based on the data associated with features in your map. Themes provide a visual
representation of the data. For example, a typical theme for a point layer might display retail store
locations with a different symbol for each type of store, or a polygon layer theme might display each
land use classification with a different color or shading.
A theme consists of a collection of rules. Each rule specifies a style and feature label for the features
that meet the specified condition. You can add a legend label to provide a description of a rule's
condition. As a layer is drawn, each feature is compared to the rules in the order that they are listed.
The first rule for which the feature meets the condition is used to specify the style and feature label for
that feature. A default or empty condition applies to all features and defines the style for features that
do not meet any of the preceding rules. A well constructed theme contains only one default rule and it
is last in the list.
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Distribution Methods
Themes can render feature sources based on individual values such as zoning designation, or by
a range, such as property assessment values. When theming with numeric ranges the following
distribution methods are available.
Equal

The difference between the high and low values is the same for every range. This
method is easy to interpret and is useful for showing continuous data such as rainfall.

Standard
Deviation

Features are placed in ranges based on how much their values vary from the mean.
MapGuide Studio calculates the mean and then adds or subtracts the standard
deviation to or from the mean to create the ranges.

Quantile

Each range contains an equal number of features. This method is useful for showing
data in which values are evenly distributed.

Jenks (Natural
Breaks)

Ranges are based on natural groupings of data values. Features with similar values
are grouped together. This method shows the natural groupings in the data.

Theme dialog box

Although theming layers in Autodesk MapGuide Studio is done only with feature
sources, you can also create themes using AutoCAD Map 3D and store the stylization
in the drawing source (DWF).
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Drawing Sources
Changes you can make to the drawing source (DWF) are the scale range, the print layout, and layers
you want to pull from the DWF.

Raster Sources
Other than the scale ranges, raster sources have only two style settings for a raster based layer:
■
Rebuild layer after zooming in by a factor of
■
Bitonal image settings

Rebuild Layer After Zooming In By A Factor Of
The Rebuild Layer After Zooming in by a Factor Of setting specifies the number of times the user must
zoom in before the layer is automatically rebuilt; this value is expressed as (number of times)/2. Each
time the layer is rebuilt on the server, a higher resolution version of the image is sent to the client, as
Autodesk MapGuide Enterprise dynamically samples the images as you zoom out.
If you zoom in on the map several times, the generalized detail that was appropriate when you were
zoomed out might now be too coarse, so you will want to rebuild the layer to use the proper amount
of detail at this zoom level. A factor of three is sufficient, but if you require better detail when zooming
in, decrease the number. However, because rebuilding takes time, you should set this number as high
as possible to avoid unnecessarily slowing down performance when the user zooms. If the zoom factor
is zero, the layer will not be rebuilt on zooming.

Bitonal Image Settings
Bitonal Image settings are used for images that are either 1 or 0 in terms of pixel settings. For bitonal
raster images, foreground color (1 or “on” pixels) is black by default and background color (0 or “off”
pixels) is white. You can specify the following settings for the foreground and background colors:
■
Background window color (of the map)
■
Transparent
■
Any color from palette
These bi‐tonal settings are ignored for any multi‐tonal image, such as full‐color or grayscale images.
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Filtering Data on a Layer
You use expressions to filter geospatial data, select a subset of data, calculate values, or convert data
from one data type to another. Use numeric expressions to apply math functions to properties with
numeric values.
The subset of the data can be filtered by any of the features properties. Those properties can be
modified with built‐in functions such as Math, Text, and Date functions.
The data can also be filtered geometrically using the Geometric function such as Area and Length of
the object.
The Create/Modify Expression window that is used for filtering is also used for URLs, tooltips, labels,
and thematics.

Filtering Parcels Layer based on Geometric Area and Wildcard Properties

Adding URLs to Features
Each layer may have URLs attached to the features. There is no requirement for the full URL to be
stored in the data. The hyperlink can be built with the existing data concatenated with a string to form
a URL.
The Create/Modify Expressions dialog box provides the functions to merge strings with feature
properties.

URL added to Features
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In the Create/Modify Expression dialog box, make sure that the strings are enclosed
in single quotes. Feature property names must be enclosed in double quotes.

Adding Tooltips to Features
Tooltips are used to view information about the map features by resting your cursor over the feature.
Tooltips are a fast way to get attribute information about the feature. You use the Create/Modify
dialog box to combine feature properties, geometry attributes, and strings to create tooltips.

Tooltip as a Combination of Strings, Properties, and Geometry

When using the Create/Modify Expressions dialog box, the CONCAT function can only
combine two items at a time. You may want to nest the CONCAT functions. A, B, and
C can be concatenated by CONCAT(CONCAT("A","B"),"C").
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Exercise: Create a Point Layer from a Database
In this exercise, you create a Manhole layer based
on the latitude and longitude coordinates stored in a
database.

The completed exercise

Create a Point Layer from a Database
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

■

2.

In Site Explorer:
■
Under REDDING, click the 3_LAYERS folder.
■
Right‐click New > Layer.

3.

In Layer Editor:
■
For Data Resource Used in this Layer, click
Browse.
In the Open Resource dialog box:
■
Browse to Library://REDDING/2_DATA/
■
Select REDDING_MSACCESS.
■
Click Open.

4.
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5.

Under Feature Data Setup:
■
For Feature Class, select
Default:MaintenanceHole.
■
In the Reset to Defaults dialog box, click
OK.

6.
7.

For Geometry, select Geometry.
For Properties Displayed in Viewer, click Select
All.

8.
9.

10. On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Layer Preview pane, click Refresh.

Note: The MH_ID field should now be
selected.
Click File menu > Save.
In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/3_LAYERS/ folder.
■
For Resource Name, enter: M‐Holes
■
Click Save.
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Exercise: Create a Themed Zoning Layer
In this exercise, you modify a basic Zoning layer.
The Zoning layer is a SDf file created by a Load
Procedure that processed a SHP file. You use the
Zoning Classification property to color code the
polygons within the layer. You also use the Zoning
Description property as a tooltip.

■

■
■
■

2.

For Site, enter: http://localhost/
mapguide2010
For User ID, enter: Administrator
For Password, enter: admin
Click OK.

In Site Explorer, under REDDING/3_LAYERS,
right‐click the Zoning layer.
■

The completed exercise

Theming the Zoning Layer
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:

■
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3.

4.
5.

Under Properties Displayed In Viewer, click
Select All.

For Tooltip Displayed for Feature, click the
Browse button.
In the Create/Modify Expressions dialog box:
■
Click Property > ZONE_DESC.
■
Click OK.

7.

Under 0 ‐ Infinity: Area Style, click Theme.

8.

In the Theme dialog box, under Create a
Range of Conditions, for Property, select
ZONE_CLASS.

9.

Under Interpolate Styles Under Range of
Conditions, click Browse.

10. In the Style Area dialog box:
■
For Foreground color, for From, select a
light green color.
■
For Foreground color, for the To, select to a
pink color.
■
Click OK.

6.

In the Style area, under 0‐Infinity: Area Style,
click Theme.
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11. In the Theme dialog box, click OK.

12. Click File menu > Save Zoning.
13. On the MapGuide Studio toolbar:
■
Click Preview.
■
Click Refresh.
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Exercise: Create a Roads Layer
In this exercise, you modify a Roads layer. The Roads
layer was created with a Load Procedure based on a
SHP File. You create a tooltip that concatenates the
Road Name with the Road Type. You also label the
roads based on its road name property.

2.

In Site Explorer, under REDDING/3_LAYERS,
right‐click the Roads layer > Open.

3.

Under Properties Displayed In Viewer, click
Select All.
Under Tooltip Displayed for Feature, click the
Browse button.
In the Create/Modify Expressions dialog box,
click Text Function > Concat.

4.
5.

The completed exercise

Add a Roads Layer
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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6.

Click Property > ST_NAME.

7.

In the Expression window:
■
Click [date/time].
■
Click Text Function > Concat.

9.

In the Expression window:
■
Select [date/time].
■
Click Property > ST_TYPE.
■
Click OK.

10. In the Style area, under the 0 ‐ Infinity: Line
Style, for Style of the Geometry, click Browse.

8.
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In the Expression window:
■
Click [text property ].
■
'a single space, enter: ' '

■
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11. In the Style Line dialog box:
■
Change the line color to Red.
■
Click OK.

13. In the Style Label dialog box:
■
Click Advanced Placement.
■
For Property to Display, select Name.
■
Click OK.

12. In the Style area, under the 0 ‐ Infinity: Line
Style, for Feature Label, click Browse.
14. Click File menu > Save Roads.
15. On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Layer Preview pane, click Refresh.
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Exercise: Create a Layer with Joined Database
In this exercise, you create a Hydrant layer based on
the Hydrant.shp. This data is linked to a database, the
tool tips will be based on the attributes in the Joined
database.

2.

In Site Explorer:
■
Under REDDING, select the 3_LAYERS
folder.
■
Right‐click New > Layer.

3.

Under Layer Editor, for Data Resource Used in
this Layer, click Browse.
In the Open Resource dialog box:
■
Browse to Library://REDDING/2_DATA/
■
Select REDDING_SHP.
■
Click Open.

4.

The completed exercise

Create a Layer with Joined Database
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
5.
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Under Feature Data Setup, for Feature Class,
select Default:Hydrant_Join.
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6.

For Properties Displayed in Viewer, click Select
All.

7.
8.

For Tooltip Displayed for Feature, click Browse.
In the Create/Modify Expressions dialog box,
click Text Function > Concat.

9.

In the Expression window:
■
Click [text property].
■
Enclosed in single quotes, enter:
'Maintained by: '
■
Click [date/time].
■
Click Property >
Hydrant_Maintenance_JoinMAINTAINEDBY
■
Click OK.

11. Under 0 ‐ Infinity: Point Style, for Style of the
geometry, click Browse.

12. In the Style Point dialog box, under Symbol,
select Font Symbol.
13. In the Font Symbol dialog box:
■
For Font, select Webdings.
■
Select the backward slash, number 92.
■
Click OK.

10. Under Style, for Scale Ranges, for To, enter:
10000
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14. In the Style Point dialog box:
■
For Text color, select Red.
■
Click OK.

17. On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Layer Preview pane, click Refresh.
■
Under Zoom to A Scale Range, click 0 ‐
10000.

15. Click File menu > Save.
16. In the Save Resource As dialog box:
■
Browse to Library://REDDING/3_LAYERS/
folder.
■
For Resource Name, enter: Hydrants
■
Click Save.
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Exercise: Create an Airphoto Layer
In this exercise, you create a new layer that contains
two MR SID images. A Load Procedure was used
to load the two images to the server, and the
images are referenced by a single catalog called
REDDING_RASTER.

2.

In Site Explorer:
■
Under REDDING, click the 3_LAYERS folder.
■
Right‐click New > Layer.

3.

In the Layer Editor, for Data Resource Used in
this Layer, click Browse.

The completed exercise

Create an Airphoto Layer
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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4.

In the Open Resource dialog box:
■
Browse to Library://REDDING/2_DATA/
■
Select REDDING_RASTER.
■
Click Open.

5.
6.

Click File menu > Save.
In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/3_LAYERS/ folder.
■
For Resource Name, enter: Airphoto
■
Click Save.
On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Layer Preview pane, click Refresh.

7.
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Lesson: Maps
In this lesson, you create a new map, assign a coordinate system, add layers, and change their display
order.

Map Editor in MapGuide Studio

Objectives
After completing this lesson, you will be able to:
■
■
■

Describe how to create a map.
Explain how to add layers to a map.
Create a map.
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Create the Map
Once all the layers are configured, stylized and themed, you can create a map using those layers.
The stylization always occurs within the layer level of the authoring process. The maps are strictly for
bringing together the various layers to create a final web layout.
Initially, you must assign a coordinate system to a map. For feature sources (such as SHP or Oracle
Spatial) and drawing sources (such as DWF), the coordinate system of each layer is stored in the data
repositories. For performance reasons, the coordinate system of the raster files should determines
your map's coordinate system. Feature and drawing sources will re‐project dynamically to whichever
coordinate system is set in the map. Raster files will re‐project dynamically but it does take more
system resources to manipulate each image when re‐projecting.
If raster files are required, it is recommended that they are in a standard coordinate system and that
the map is set to that coordinate system when it is created.
The initial view will be shown in the units of the coordinate system chosen, and will reset to the
bounding box of the layers added to the map. If a larger scale is required, by zooming into a region,
and clicking the Use Current Map to Set These Coordinates link, the new bounding box of the map will
be set.

Preview of a map shown in MapGuide Studio

106

■

Chapter 3: Authoring with Autodesk MapGuide Studio

Add Layers
Within the map area, each layer can be added directly to the root of the legend, or a group or sub‐
group can be created. For example, when adding the water mains layer to the map, it can be put in the
utilities group, in the water sub‐group.

Layers in groups and sub‐groups

Once layers have been added, the drawing order can be set so that the raster and polygon layers do
not obscure the line and point layers.

Polygon (area) layers have adjustable transparency settings so that they can be
placed over other layers without obscuring the features.
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Layer Settings in the Map
From within the Map Settings pane, you can change a few of the map related setting for each layer.
You may wish that the layer does not appear by default, forcing the user to turn it on manually.
Also, you may wish that some of the layers are not selectable. These layers are usually background
layers that do not have any associated attribute data or reports associated.
Within the legend, you may wish that the layer shows a more friendly name that the default name.
For example, you may wish to rename the roads layer something more descriptive as like Street
Centerlines. You can also hide the layer from appearing in the legend completely.

Layer settings in Map Editor

Set Up Smooth Map Viewing
You can create a set of base map layers to enable smooth panning and zooming in the HTML (AJAX)
viewer. These layers are cached and tiled on the server so they can be quickly displayed as users move
about the map. Only specified scale ranges are cached and displayed. As users zoom in or out, the
cached layers at the nearest scale range are displayed.
This technique will greatly increase the speed at which the panning and zooming
returns a map to the HTML/AJAX Viewer, while the requested layers, which are not
cached, are still loading.
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Exercise: Create a New Map
In this exercise, you create a new map.

2.

In Site Explorer:
■
Under REDDING, select the 5_MAPS folder.
■
Right‐click New > Map.

3.

In Map Editor, under Settings, for Description,
enter: Map of Redding, California
Under the Layers, in the Layers by Group, click
the Add a New Layer button.

4.

The completed exercise

Create a New Map
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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5.

In the Select a Layer Resource dialog box:
■
Browse to the Library://
REDDING/3_LAYERS/ folder.
■
Click the Airphoto layer.
■
Click Open.

6.

Under "Airphoto" Layer Setting within the
Map:
■
Remove the check mark from Layer Is
Initially displayed in the Map.
■
For Legend Label, enter: Redding Air
Photographs

7.

In Site Explorer:
■
Expand the REDDING/3_LAYERS folder.
■
Select all the layers except Airphoto.
■
Drag the selected layers into the Layers by
Group tab.

8.
9.

Click the Drawing Order tab.
In the Drawing Order tab:
■
Drag the Airphoto layer to the bottom of
the list.
■
Use the Move Up and Move Down button
to put the layers in the following order:
❏
Hydrants
❏
Valves
❏
M‐Holes
❏
waterlines
❏
Roads
❏
Parcels
❏
Zoning
❏
Airphoto

10. Click File menu > Save.

110

■

Chapter 3: Authoring with Autodesk MapGuide Studio

11. In the Save Resource As dialog box:
■
Browse to the Library://REDDING/5_MAPS/
folder.
■
For Resource Name, enter: REDDING_MAP
■
Click Save.

12. On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Map Preview pane, click Refresh.

Note: You may want to remove the check mark
from Layer Is Initially Displayed in the Map for
other layers to reduce any clutter in your map.
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Chapter Summary
Having completed this chapter, you can:
■
■
■
■
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Explain the difference between data loading and data connections within MapGuide Studio.
Describe the data loading process in MapGuide Studio.
Create layers in MapGuide Studio.
Create maps in MapGuide Studio.

■
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Chapter

4
Basic and Flexible Web Layouts
Autodesk MapGuide® Studio is used to create and customize a web layout in preparation for web
deployment. Some of the tools within MapGuide Studio, such as customizing buttons, do not require
coding or elaborate programming. This chapter reviews both the Basic Web Layout and the Flexible
Web Layout tools.

Objectives
After completing this chapter, you will be able to:
■
■

Create a basic web layout in MapGuide Studio.
Describe the components of the Flexible Layouts and how to customize the various components.

Chapter Overview
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Lesson: Basic Web Layouts
In this lesson, you explore basic web layouts that are created in MapGuide Studio. Basic web layouts
combine the map with associated tools such as toolbars, context menus, and task bars. The basic
web layout can be launched with either the AJAX or DWF™ Viewers. The tools, menus, and tasks are
completely compatible regardless of type of viewer. Launching the basic web layout provides a simple
and rapid way of publishing your map to the Internet.

Basic Web layout in Internet Explorer

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■
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Describe the web layout.
Create a web layout.
Describe the areas of web layout that can be customized.
Describe the built‐in commands.
Explain how to create custom commands.
Customize the web layout.

■

Chapter 4: Basic and Flexible Web Layouts

About Web Layouts
Introduction to Basic Web Layouts
The Autodesk MapGuide Viewer can be used with most web browsers.
There are two types of the Autodesk MapGuide® Enterprise Viewers:
■
The downloadable viewer is based on a Microsoft ActiveX control and has full support for the DWF
format. It works with the Microsoft Internet Explorer browser installed on a Windows computer
only.
■
The HTML viewer (or “zero‐client AJAX viewer”) does not need a download. It works with most
browsers such as Microsoft Internet Explorer or Mozilla Firefox on most operating systems.
You can customize the appearance of the viewer and select which toolbar commands you want to use
with a template called a web layout. Of course, you can also add features and functions to the basic
layout using your own programming code.

Creating Basic Web Layouts
After you create a map, you can build a basic web layout so that users can view and interact with
the map on the Internet or an intranet. You can preview your map and layout in the Web Layout
Editor. You can also view your web layout in a browser using the AJAX Viewer or the DWF Viewer using
Autodesk® Design Review.

Layer, Map, and Web Layout Dependency
In Autodesk MapGuide Studio, the stylizing of the layers is done at the layer level of the map, so that
if the layer color changes, such as road changes from red to black, it is seen in any map that uses that
layer.
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Development of a map

Since each web layout has its associated map, the map defines which layer is in the web layout.
Therefore, in order to change the color of a layer in the web layout, you will have to know what map
is used by that web layout, and which layer is used in that map. Then the layer can be modified. This
level of granularity will ensure that there is easy modification of how the final web layouts appear.
When you build a new web layout, you only need to specify the map to display. All other settings have
default values. Use the Web Layout Editor to perform the following tasks:
■
Create a new web layout and specify the map to display.
■
Modify default web layout settings.
■
Design viewer toolbars, context menus, and a task pane.
■
Create custom commands.
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Exercise: Create a New Web Layout
In this exercise, you create a new basic web layout
and open the web layout in a browser. Both AJAX and
DWF Viewers will be used.

2.

In the Site Explorer, under REDDING, right‐click
6__SIMPLE_LAYOUTS > New > Web Layout >
Basic Layout.

3.

In the Web Layout Editor, for Text for Browser
Bar, enter: Redding, California
For Map Used in this Layout, click the Browse
button.
In the Open Resource dialog box:
■
Browse to Library://REDDING/5_MAPS/.
■
Highlight REDDING_MAP.
■
Click Open.

4.
5.
The completed exercise

Create a New Web Layout
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

6.

Click File menu > Save.
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7.

In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/6_SIMPLE_LAYOUTS/ folder.
■
For Resource Name, enter:
REDDING_BASIC_LAYOUT
■
Click Save.

8.

In the Web Layout Editor,:
■
Scroll down to the Preview in Browser
Using AJAX Viewer.
■
Beside the AJAX URL, click Go.

10. In Internet Explorer:
■
Zoom and Pan within the map.
■
Turn the Layers on and off.

11. In Autodesk MapGuide Studio, for Preview In
Browser with DWF Viewer, click GO.
9.
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A new web browser will appear. In Connect to
Localhost dialog box:
■
For User Name, enter: Anonymous.
■
Leave the Password blank.
■
Click OK.

■

Chapter 4: Basic and Flexible Web Layouts

12. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous.
■
Leave the Password blank.
■
Click OK.

Note: To view this layout with DWF, you must
have Autodesk Design Review installed and you
must use Microsoft Internet Explorer.
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About Customizing Basic Layouts
There are three areas within the web layout that can be customized: the Toolbar, the Context Menu,
and the Task bar Menu.
These areas can all contain the same buttons and commands regardless of where they reside.

Toolbar
The toolbar is the set of tools that are available at the top of the AJAX or DWF Viewer interface and
customizable within the Basic Web Layout.

Toolbar

Context Menu
The context menu is available when you right‐click over a map area.

Context menu
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Task Bar Menu
The task bar menu is available in the top‐right corner of the AJAX and DWF viewers. To display the task
bar, you click the Tasks button.

Task bar menu

Built‐in Commands
All the menus and toolbars are customizable in Autodesk MapGuide Studio. There are 28 built‐in
commands that can be accessed from task bar menu, toolbar, or context menu areas.

Built‐in commands in MapGuide Studio
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Most commands work in either the DWF or AJAX viewers. The commands that will not work in both
viewers are:
■
Print – Works only with the DWF Viewer.
■
Get Printable Page – Creates a new HTML page for printing with the HTML Viewer.
■
Zoom Dynamic – Enables the dynamic zoom for the DWF Viewer.
All other commands are interchangeable between the HTML and DWF viewers.
The DWF Print command requires a print layout. Any custom print layouts can be
added to this command as part of Additional Parameters to create a custom printout
for the DWF Viewer.

Example Built‐in Command
Some built‐in commands can be customized to perform different tasks.
For example, the Buffer command, which enables the user to buffer the selected objects on the map,
has a parameter that can be changed to launch the interface into the Task pane, a new window, or a
named frame.

Buffer customizable built‐In command

Custom Commands
You can create four key types of custom commands: Invoke URL, Invoke Script, Search, and the
Modified Built‐In Command.
Most of the icons for the commands for the Basic Web Layouts are stored in Windows in the C:
\Program Files\Autodesk\MapGuideEnterprise2010\WebServerExtensions\www\stdicons\ folder.
You can also use a URL to any web‐supported image (for example, PNG, GIF, or JPG).

Custom command image
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About Invoke URL
With the invoking a URL function, you can create a button that calls any URL and, optionally, can send
the selected objects in an XML variable. InvokeURL can also be targeted to any frame or window.
For example, an Invoke URL button to open a document about metadata called http://myserver.com/
metadata.jsp can open in a new window.
You can also use invoking a URL to launch reports. You can use the interface to capture the keys of
selected objects on the map and send those internal MapGuide IDs to a URL contained in an XML
variable. The page that receives the list of IDs in XML can then use the Autodesk MapGuide Enterprise
API to extract the required attributes on the selected objects.
These attributes could then be sent to a page in order to query a database to generate a report. At this
point, any reporting‐based HTML language can be used such as PHP, ASP .NET, JSP, or ColdFusion.

Invoke URL
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About Invoke Script
The Invoke Script tool works much like the Invoke URL tool except that the script is a JavaScript/
VBScript that is the client side on the web page. For example, if you had a JavaScript function that
displayed the time, the function could be called with a command from within either the HTML or DWF
viewer interface. The function would have to be already downloaded in a frame in the interface in
order to work.
In order to load the JavaScript, you may want to include a URL in one of the frames. You may have a
JavaScript function in a page called taskpane.php. To include that file in your interface your URL will
have to point to it in the web layout.
Also, the Autodesk MapGuide Enterprise viewer has a Viewer API that can be called with JavaScript or
VBScript. The Invoke Script tool can also call these pre‐made functions.

Invoke Script

About Search
The Search command is a customizable command used to searching for and zooming to a feature.
It can also be called a Zoom‐Goto. Using the Search command you can choose what to match. For
example, if you want to find an address, you can search on Parcel ID and the resulting matches can be
the Address and Street Name.

Search setup in web layout

124

■

Chapter 4: Basic and Flexible Web Layouts

Exercise: Customize the Web Layout
In this exercise, you create a Toolbar button and a
Context Menu item to zoom to a user‐entered scale.
An Invoke Script is used to call JavaScript to get the
X and Y coordinates of the center of the current map
and prompt the user to enter a scale. A MapGuide
function called ZoomToView is called to zoom into the
current location at the scale the user entered.

2.

In the Site Explorer window, in the
REDDING/6_SIMPLE_LAYOUTS folder, double‐
click REDDING_BASIC_LAYOUT.

3.

In the Web Layout Editor, under New
Commands, make sure that Show Custom
Commands is selected.

4.

Click Add > Invoke Script.

The completed exercise

Customize the Basic Web Layout
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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5.

In the Settings tab, do the following:
■
For Command Name, enter: Zoom to Scale
■
For Name to Display in the Interface, enter:
Zoom to Scale
■
For Tool Tip to Appear on Hover, enter:
Zoom to Scale
■
For Description to Appear on the Status
Bar, enter: Zoom to Scale

11. Finally, zoom into the map based on our scale
and coordinates, enter:
myMap.ZoomToView(X,Y,Scale,true);

12. Scroll up to the Toolbar and Menus, click the
Toolbar tab.
13. Click Add > Add Command > Zoom to Scale.

6.

For the URL to an Image Enable State and URL
to an Image Disabled State, leave both as the
default.
7. Click the Additional Parameters tab.
8. For Script to Invoke, for the first line, enter: var
myMap = parent.parent.mapFrame;
Note: In JavaScript, this will get the Map frame
so that we can use the map functions for
getting the center of the map and setting the
scale.
9. Next, to get the x and y coordinates of the
center of the map, enter:
var X = myMap.GetCenter().X;var Y =
myMap.GetCenter().Y;
10. We need to prompt the user to enter the scale
and make sure the scale is an integer, enter:
var Scale = prompt("Enter Scale:", "");Scale =
parseInt(Scale);
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14. Click the Move Down button until the Zoom to
Scale item is at the bottom of the toolbar.
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15. Click the Context Menu tab.

16. Click Add > Add Command > Zoom to Scale.
17. Click the Move Down button until the Zoom
to Scale item is at the bottom of the Context
Menu.
18. Click File menu > Save
REDDING_BASIC_LAYOUT.
19. In the Web Layout Editor, under Preview in
Browser Using AJAX Viewer, click GO.
20. A new web browser will appear. In Connect to
Localhost dialog box:
■
For User Name, enter: Anonymous.
■
Leave the Password blank.
■
Click OK

22. In the Explorer User Prompt dialog box:
■
For Enter Scale, enter: 15000
■
Click OK.

Map Zooms into 1:15,000 Scale.

23. Right‐Click over the map > Zoom to Scale.

21. In the browser, click the Zoom to Scale button
in the toolbar.
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24. In the Explorer User Prompt dialog box, for
Enter Scale, enter: 5000

Map zooms in to 1:5,000 scale.
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Lesson: Flexible Web Layouts
In this lesson, you create a Flexible Web Layout using one of the available templates. You customize
the Flexible Web Layout and modify the interface.

Maroon Flexible Web Layout in Internet Explorer

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■
■
■

Describe Flexible Web Layouts.
Explain how layout templates are used in flexible templates.
Create a Flexible Web Layout.
Describe how to customize Flexible Web Layout toolbars.
Describe how to customize a search component.
Explain how to create and use an Overview Map.
Customize the Task Pane.
Create a search component.
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About Flexible Web Layouts
With Flexible Web Layouts you can select from a number of templates to create your MapGuide‐
based web application. The new Flexible Web Layouts include support for Overview Maps, selected
attributes, and measuring tools. The AJAX Viewer uses the popular Open Layers project for both non‐
tiled and tiled maps. Autodesk MapGuide Studio includes complete support for authoring applications
with Flexible Web Layouts. This includes the ability to easily switch between templates.
Several containers in the Flexible Layout that can be customized. Components, such as pan or zoom, in
some of the following containers can be customized:
■
■
■
■
■
■
■

Toolbars (main, horizontal, and vertical)
Selection panel or pane
Task panel or pane
Legend panel or pane
Right‐click menu
Status bar
Overview Map panel or pane

Measuring Tools with MapGuide Flexible Layout in Internet Explorer

Flexible Layouts are similar to a set of pre‐made code snippets that you would use to customize
MapGuide. Prior to Flexible Layouts, MapGuide developers would be required recreate code and
tools, such as Overview Maps or Selection lists, that are now part of Flexible Layouts.
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Example of Flexible Layouts
With Flexible Layouts, you can apply a number of templates. Each template locates the Overview Map,
Selection Pane, Task Pane, and Layer Pane in various places on the screen. Each pane, including the
map, has a tab in MapGuide Studio where you can customize the buttons and functionality of the
pane.

Customizing Vertical Toolbar in Flexible Web Layout

Basic Layouts has a task pane, shortcut menu, and a legend. With Flexible Layouts, you can customize
the style, content, and layout of these in MapGuide Studio.

Layout Templates
You can choose any one of the five templates to create your web layout. If you select the Aqua,
LimeGold, or TurquoiseYellow templates, the containers, such as Legend, Selection, and Tasks, are
displayed in a tab format. If you select the Maroon or Slate templates, the containers are displayed in a
pane format.
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Technology Used
The Web Layout templates are installed when you install Autodesk MapGuide Enterprise
‐ Web Server Extensions. The template files are located in: C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions\www\fusion templates\
The Web Layout templates consist of XML files, images, and Cascading Style Sheets (CSS) files The
XML files determine whether the layout will use panels or floating windows. The images are the
custom buttons and logos. The CSS files determine the color and style of the panels.
DWF and Flexible Web Layout Templates
Since the templates are based on the AJAX Viewer in MapGuide, you cannot use the
Flexible Web Layout templates with the DWF Viewer. If you want to use the DWF
Viewer, you must use the Basic Web Layout.
A Web Layout template is like a profile in AutoCAD® where the user interface is customized according
to the loaded profile. The user interface in this case is completely viewed on the Web.

Example of Web Layout Template
The LimeGold Web Layout template has a tabbed appearance for the containers. The tabs are docked
on the right side of the Web page. The Tasks, Legend, Selection, and Overview Map containers can be
hidden by clicking the bar between the containers and the map.

LimeGold Web Layout Template in Internet Explorer

132

■

Chapter 4: Basic and Flexible Web Layouts

Exercise: Create a Flexible Web Layout
In this exercise, you create a Flexible Web Layout
using a pre‐existing map.

The completed exercise

2.

In Site Explorer:
■
Under REDDING, click the
7_FLEXIBLE_LAYOUTS folder.
■
Right‐click New > Web Layout > Flexible
Layout.

3.

In the Web Layout Editor, under Select a
Template for the Web Layout, select Slate.

4.

For Web Page Title, enter: Redding California
Flexible Web Layout
Under Configure Components of the Selected
Template, click the Map tab.
For Map Resource Used in this Layout, click
Browse.

Create a New Flexible Web Layout
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

5.
6.
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7.

In the Open Resource dialog box:
■
Browse to the Library://REDDING/5_MAPS/
folder.
■
Highlight the REDDING_MAP.
■
Click Open.

8.
9.

Click File menu > Save.
In the Save Resource As dialog box:
■
Browse to the Library://
REDDING/7_FLEXIBLE_LAYOUTS/ folder.
■
For Resource Name, enter:
REDDING_FLEXIBLE_LAYOUT
■
Click Save.

10. On the MapGuide Studio toolbar:
■
Click Preview.
■
In the Web Preview pane, click Refresh.

11. Click Edit.
12. Under Web Address of this Layout, click View
In Browser.

13. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous
■
Click OK.
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14. Pan and zoom to view the layout in your
browser.

19. Pan and zoom to view the layout in your
browser.

15. In MapGuide Studio, for the
REDDING_FLEXIBLE_LAYOUT, in the Web
Layout Editor, for Select a Template for the
Web Layout, select Maroon.

16. Click File menu > Save
REDDING_FLEXIBLE_LAYOUT.
17. Under Web Address of this Layout, click View
In Browser.
18. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous
■
Click OK.
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About Toolbars
MapGuide Studio provides the following toolbars: the Main Menu toolbar, the Primary toolbar,
and the Vertical (or Secondary) toolbar. You can customize all toolbars by specifying additional
components to include. If you have customized the right‐click menu or task list menu, you can use
those components in the toolbars.

Toolbars in LimeGold Web Layout Template

MapGuide Studio provides a set of built‐in basic components, such as Zoom, Pan, and Measure, as
well as three advanced components: Invoke Script, Invoke URL, and Search that you can add to your
toolbar.
You cannot modify or delete the built‐in components, but you can add or remove them from your
toolbars by dragging the component to the toolbar. The orientation of the toolbars may determine
the what kind of component you will add. If you add a component to the Horizontal toolbar, you may
want to add components without labels. Your choice is determined on the Web Layout template you
choose.
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Adding a Measure Component to the Secondary Toolbar

Toolbar Orientation
Toolbars can be displayed vertically or horizontally. The flyouts can be set to left or right for the vertical
toolbars and up or down for the horizontal toolbars. The settings of the toolbars are pre‐set with the
Web Layout templates. If you change the orientation without modifying the settings of the Layout
template (by modifying the CSS file), the toolbar will be incorrectly oriented.

Incorrect Vertical Orientation Toolbar in the Slate Web Layout Template
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Customizing the Search Component
Search components are used to search for features in the map. You can select the resulting attribute
in the map and zoom and highlight the resulting object.

Search Component in Task Pane

Search Component
You can find and select features in your map based on their properties. You create an expression that
specifies a set of conditions to use for finding and selecting the features. The attributes of any existing
layer can be used to search for features. Using the Create/Modify Expressions dialog box, you can be
very creative in the types of searches you can create.
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Process: Creating Search Components
Search components are used to find a geographic feature on a map by searching by some attribute of
the feature.
1.

Make sure that the layer you are going to
use to search is available in the map.

2.

Within the Flexible Web Layout, choose a
toolbar, task menu, or right‐click menu to
customize.

3.

Add a new component that will be available
to use in the container.

4.

Change the label and tooltip names of the
new search component.

5.

Build the search based on the properties
of the layer that is being selected. Use the
percent sign (%) as a wild card.
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6.

Select the properties of the layer that will be
displayed as part of the search results.

7.

Drag the new search component into your
toolbar, task menu, or right‐click menu
container.

8.

Use the Search function in your browser.

Guidelines for Creating Search Components
■

■

■
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Make sure that the layer you are searching for has the correct properties. For example, if
searching for Parcels, make sure that the address properties are part of the layer. Otherwise, you
may want to create a join and use the attached data for your search.
You do not need to recreate the search component multiple times for each container. Once your
create the search component, you can add it to any toolbar or the right‐click or task menus.
To ensure optimum performance, when you add a wild card, the percent sign (%), make sure that
you set the Returns a List of Results No Larger Than setting to the default of 100 or lower.
When you add the search component to the Vertical toolbar, do not enter any values for Label to
Display in the Interface.
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Creating an Overview Map
Depending on the Flexible Web Layout template you use, the Overview Map is displayed either in a
pane or a panel. The Overview Map displays the current zoom of the main map as a dashed red line.
By default within the Flexible Web Layout, the Overview Map uses the same map as the main window.
Often, a simpler map is created to use in the Overview Map so that the rendering is faster and simpler
to view.

Overview Map Container in a Flexible Web Layout

The Overview Map is similar to the birds‐eye view or inset map found on a paper map. The Overview
Map is far more dynamic than the inset map in that it reduces in area as you zoom in on the main map.
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Example of the Overview Map
In the Maroon Flexible Web Layout template, the Overview Map is docked into a panel. As you zoom
into the main map, the Overview Pap zooms in. The Overview Map in this example only has the
Parcels layers showing.

Overview Map in Maroon Flexible Web Layout
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Exercise: Customize the Task Pane
In this exercise, you modify the Task Pane menu of
the Maroon Web Layout. You add a a series of new
select items such as Select Polygon, Select Radius, and
Select Within.

2.

3.

In Site Explorer:
■
Under the REDDING/ folder, select
7_FLEXIBLE_LAYOUTS/ folder, select
REDDING_FLEXIBLE_LAYOUT.
■
Right‐click Open.
In the Web Layout Editor, under Configure
Components of the Selected Template, click
the Task Pane: Task Menu tab.

4.

Click Add > New Separator.

5.

Under Items Displayed in Container:
■
Select the Separator.
■
Use the Move Item Down button to move
the separator to the bottom.

6.

Under Components Available in this Layout,
click Details.

The completed exercise

Customize the Task Pane Menu
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.
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7.

Drag and drop Select Polygon, Select Radius,
and Select Within below the separator.

Click File menu > Save
REDDING_FLEXIBLE_LAYOUT.
9. In the Web Layout Editor, click View In Browser.
10. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous
■
Click OK.
11. Drag the Task Pane so that it is approximately
50% of the height of the map.
12. Click Task List > Select Polygon.

13. In the map:
■
Draw a polygon on the screen.
■
Double‐click to finish the polygon selection.

8.
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14. Use the Selection Pane to view the associated
data for each of the selected features.
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Exercise: Create a Search Component
In this exercise, you create a new search component
so that you can search for a parcel based on a street
name. The component will be added to the vertical
toolbar of the existing Maroon Flexible Web Layout.

2.

3.

In Site Explorer:
■
Under the REDDING/ folder, select
7_FLEXIBLE_LAYOUTS folder, select
REDDING_FLEXIBLE_LAYOUT.
■
Right‐click Open.
In the Web Layout Editor, under Configure
Components of the Selected Template, click
the Toolbar (Vertical) tab.

The completed exercise

Create a Search
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

4.

Under Components Available in this Layout,
click New.
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5.

In the Create a New Component Based on a
Master Type dialog box:
■
Click Search.
■
Click OK.

6.

Under Parameters for Selection Item:
■
For ID, enter: SearchForParcelNoLabel
■
For Label to Display in the Interface, delete
Search and leave the box empty.
■
For Tool Tip to Appear on Hover, enter:
Search for Parcel
■
For Description to Appear on the Status
Bar, enter: Search for Parcel

7.

8.

In the Select dialog box:
■
Click Parcels.
■
Click OK.

9.

For Pass the Search Item into this Filter, click
Browse.
10. In the Create/Modify Expressions dialog box:
■
Click Property > STNAME

Under Parameter For Selected Item:
■
For Display this Prompt for the Users to
Enter a Search Term, enter: Enter Street
Name of the Parcel:
■
For Search this Layer, click Browse.

■
■
■
■
■

■
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Click LIKE.
Click Get Values.
Select $USER_VARIABLE.
Click Insert Value.
At the end of the $USER_VARIABLE and
before the single quote, enter: %
Click OK.

11. Under Use These Columns to Display the
Results Returned by this Search Command,
click Add twice.

15. Under Component Available in this Layout:
■
Click the SearchForParcelNoLabel
component.
■
Drag the component into Items Displayed
in Container.
■
Use the Move Item Down button to put the
component below the new separator.

12. Under Title:
■
For the First Item, enter: House Number
■
For the Property, select ADDRESS
■
For the second item, for title, enter: Street
■
For the Property, select STNAME

13. For Target, select Task Pane.
14. Under Item Displayed in Container:
■
Click Add > New Separator.
■
Select the Separator.
■
Click Move Item Down to move the
separator to the bottom of the list.

16. Click File menu > Save
REDDING_FLEXIBLE_LAYOUT.
17. In the Web Layout Editor, click View In Browser.
18. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous
■
Click OK.
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19. In the browser, on the vertical toolbar, click
Search for Parcel.

21. In the Search Results pane, click 2056 CANAL
DR.

20. In the Tasks Pane:
■
For Enter Street Name of the Parcel, enter:
Can
■
Click Find.
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Chapter Summary
Having completed this chapter, you can:
■
■

Create a basic web layout in MapGuide Studio.
Describe the components of the Flexible Layouts and how to customize the various components.

Chapter Summary
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Chapter

5
Application Development
In this chapter, you learn about the four application programming interface (API) environments,
including MapGuide Web Server, FDO, Studio, and Viewer. Each of these API environments enables you
to customize Autodesk MapGuide® Enterprise in many ways, both on the server and on the desktop.
You learn that each API has its own location for development. The Web Server components are
developed to be run on the server, the Studio API to be run on the workstation, and the Viewer API
to be run in the web browser client. Since much of the FDO API is wrapped with the Web Server
extensions, you do not need to know it in order to develop with MapGuide Enterprise. However,
the FDO API is a very good option for cross‐platform programmers and can be run on the server or
workstation.
Although you review MapGuide related code, you do not perform any programming in this chapter.

Objectives
After completing this chapter, you will be able to:
■
■
■
■

Decide how to choose the MapGuide Enterprise Web Server Extension and development language.
Explain the purpose of the Web Server Extensions API.
Explain the difference between the FDO, Viewer and MapGuide Studio API.
List the advantages of using an Integrated Development Environment (IDE).
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Lesson: Development Language Options
Installing web extensions on your server requires that you make a choice of development
environments. With MapGuide, these are PHP, .NET, and JAVA. The extension you choose depends on
the skills of the developer developing the site. Often, the choice is made based on the organization or
company's standards or knowledge.

Choosing type of development with server extension

Objectives
After completing this lesson, you will be able to:
■
■
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Describe the key development languages for MapGuide.
Explain the origins and functionality of PHP.

■
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About Programming Languages
This section covers the main programming languages for Internet development with Autodesk
MapGuide Enterprise. With Autodesk MapGuide Enterprise web extensions, you can choose one of the
following web scripting languages:
■
PHP
■
ASP.NET
■
Java
Regardless of the language chosen, all three scripting languages tend to work the same way: a
modified type of HTML with its own tags is read by the web server after being requested by a browser,
interpreted by the server process, and then a standard form of HTML is returned to the browser.
For example, if a user requests the getmap.aspx file from Internet Explorer, the file is first read by the
IIS and any server‐side code is interpreted by the Microsoft .NET Framework.
The code may request a JPG version of a map. Once the map is generated by the code using .NET, the
JPG is embedded within a standard HTML page and sent back to the Internet Explorer browser.

ASP.NET and PHP server requests

PHP 5.1.2 or later is required for running the Autodesk MapGuide Enterprise Site Administrator, so it is
also used in this course for the API and development of the custom interface.
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PHP, ASP.NET, and JSP/Java
PHP started out as a Perl (Practical Extraction and Reporting Language) hack. It has since evolved to
PHP 5, originally rebuilt in 2004 and now the most recent version of PHP, at the time this document
was published, is 5.2.9.
Other than for the Autodesk MapGuide Enterprise Site Administrator, PHP version 5 is also required
because of its Object Oriented Programming (OOP) model and its XML support. XML is the main
format of storage of all the settings for the site repositories.
PHP also natively supports many databases, including MySQL, Oracle, Sybase, Informix, Microsoft SQL
Server, PostgreSQL, and even Microsoft Access.
PHP is Open Source, and as such, it is completely free to use and distribute and can be recompiled
with modifications to the source code. PHP can be downloaded from http://www.php.net

Disadvantages of PHP
Although PHP is always installed with MapGuide Enterprise Web Server Extensions is still has a few
disadvantages:
■
Has no bundled Integrated Development Environment (IDE) like asp.net.
■
Contains little debugging and error management and may be more difficult that other
environments (i.e. silent errors).
■
Does not support Namespaces.
■
Provides many similar and perhaps confusion functions (i.e. sort(), asort(), kSort()).
Within PHP, its ease of use and rapid development cycle by far makes up for any disadvantages it may
have.

Microsoft ASP .NET
Microsoft ASP .NET is a scripted language that uses the .NET framework to interpret the code into
HTML pages on demand. Visual Basic.NET, Visual C#, and Jscript .NET are all supported scripting
languages with ASP.NET. Regardless of the scripting language that is chosen, ASP.NET requires the web
server to be Internet Information Server (IIS) installed on a Windows operating system.
Some third‐party open source products such as MONO (http://www.mono‐
project.com), provide wrappers for the .NET Framework to run on Linux with
Apache, but ASP.NET would not be officially supported on Linux.
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Advantages of ASP.NET
ASP .NET applications can be developed with development tools such as Microsoft Visual Studio .NET.
WYSIWYG (What You See Is What You Get) environments found in tools such as Visual Studio not
only speed up development, but reduce the amount of coding knowledge required to develop an
application. Auto‐complete tags, visual representations of the code, integrated debugging support, and
easily‐accessed objects make these sorts of environments invaluable.
Migration to the web for those applications coded in Visual Basic .NET or C# is extremely simple.
Many developers who use Microsoft Visual Studio already know the object model and code styles for
ASP .NET. ASP .NET is extremely robust and very extensible: as the application grows, the code can
accommodate the changes.

Disadvantages of ASP .NET
Primarily, ASP .NET is confined to Microsoft operating systems and Microsoft Internet Information
Server (IIS), thus reducing the flexibility of implementation.
ASP .NET is also very memory intensive and relatively slow with processing long URLs and web paths.
ASP .NET sometimes renders HTML that does not work well with non‐Internet Explorer browsers.

Java and Java Server Pages (JSP)
Java Server Pages (JSP) are similar to PHP and ASP.NET pages as JSP also uses custom tags within an
HTML page to run server‐side applications or scripts. JSP is handled by a separate application that must
run concurrently with the web server. PHP and ASP .NET use server‐side plug‐ins to accomplish this
task rather than a whole server‐side application.
Apache Tomcat must run parallel to IIS or Apache web servers. Tomcat converts JSP pages into Java
and then compiles them on the server. Unlike PHP or ASP .NET, JSP pages are compiled with the
Java run time on the server prior to serving the application, also known as a servlet, to the client or
browser. Each time a JSP page is requested, Tomcat checks if that page has already been compiled
before re‐compiling that page.
If JSP is chosen for the Autodesk MapGuide Enterprise web extension, then a
prerequisite is to have Apache Tomcat running on the web server as well.
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Advantages of JSP
JSP can work on any platform such as Windows or Linux. Almost any web server such as Apache, IIS,
or Netscape servers can be configured to run JSP pages. Since JSP is a scripted version of Java, existing
Java developers find this language extremely easy to use.
JSP also relies on reusable, cross‐platform components like JavaBeans, Enterprise JavaBeans, and
custom tag libraries. These components have a long record of use in the industry. Organizations
developing with JSP have little trouble finding programmers that are familiar with Java.
Some other advantages of JSP include (features not found in ASP .NET):
■
Reusable, cross‐platform components.
■
Security against system crashes.
■
Memory leak protection.
■
Customizable tags.

Disadvantages of JSP
Since the JSP is compiled on the server, initialization of the Java servlets may have a slower
performance initially when compared to the interpreted languages such as ASP .NET or PHP.
Since JSP is enabled with Java servlets and beans, you are locked into the development path of using
only Java. Interpreted scripting is much higher‐level programming and does not require as much
syntactic knowledge as Java.
Although JSP and Java is often the language of choice for extremely heavy‐duty and critical
applications in a development environment, the initial learning curve may be steep and the rapid
development of applications for demonstrations or “proof of concept” will be much slower.

Language Choices
The advantages and disadvantages of PHP, JSP and ASP .NET listed here are hardly exhaustive lists.
Often, the choice of development language is already decided by current programming knowledge or
by an organization's coding standards.
For example, a developer may be very savvy with JSP/Java, but the corporation that the developer is
working for requires ASP .NET and Visual C# development. Luckily, Autodesk MapGuide Enterprise can
accommodate most development languages today.

156

■

Chapter 5: Application Development

Lesson: Web Server Extensions API
In this lesson, you learn more about the web server extensions. The web server extensions API gives
you full access to all the resources on the Autodesk MapGuide Enterprise server. All customization
to Autodesk MapGuide Enterprise is performed using the API. Three default API tools are available:
ASP .NET, PHP, and Java. All APIs are available to all three environments.
The web server extension APIs are all server‐side and do not require any installation of applications
on the client or web browser. Server‐side APIs enable you to develop regardless of the user operating
system.
The Autodesk MapGuide web extensions API consists of the following key services:
■
Site Service
■
Resource Service
■
Feature Service
■
Mapping Service
■
Drawing Service
■
Rendering Service

Graphical Classes in MapGuide Web API Reference

Objectives
After completing this lesson, you will be able to:
■
■
■

Explain the Site Service API.
Describe the Resource Service API.
Describe the key API services.
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About Site Service
The Site Service is usually the first API that any developer uses when customizing Autodesk MapGuide
Enterprise. You have to create a connection to the site server with the Site Service API.
Once the site service is attained, you can access other services.
The site service allows access to basic site‐related functionality:
■
Enumerate users.
■
Enumerate groups.
■
Create and destroy user sessions.
When a user first connects to an Autodesk MapGuide Enterprise site, the site creates a session for
that user. Subsequent requests to the site pass the session ID, which is used to manage the run‐time
map state. This keeps the state consistent between the viewer and the server across multiple HTTP
requests.

MgServiceTypes
The following is the list of MgServiceTypes for creating new services with the
siteConnection.CreateService() method:
■
ResourceService = 0
■
DrawingService = 1
■
FeatureService = 2
■
MappingService = 3
■
RenderingService = 4

Using Site Service Sample Code
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Resource Service
With the Resource Service you can manipulate repositories and resources. A resource repository stores
all the files and configuration information used by Autodesk MapGuide Enterprise.
There are two types of repositories:
■
Library repositories
■
Session repositories
A library repository is used for persistent storage. It corresponds to what is shown in the Site Explorer
when you use the Autodesk MapGuide® Studio application.
Session repositories hold data only for the user's current session, and are automatically deleted by
the Autodesk MapGuide Enterprise server if they have not been used for a certain length of time.
Autodesk MapGuide Enterprise creates session repositories automatically as required.
A repository is structured like a directory, with documents, folders, and subfolders. Each resource, and
any associated files required for that resource, are stored in one folder.
Each resource in a repository has a header that specifies the permissions required to access it.
These permissions control whether users and groups can read and/or write to a resource or folder.
Permissions can either be set explicitly for each folder or resource, or they can be set to inherit the
permissions from the parent folder. These permissions can be set with Autodesk MapGuide Studio.

Setting permissions in Autodesk MapGuide Studio
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Resource Dependencies
Resources may depend on other items:
■
Some resources, such as print layouts, are self‐sufficient and do not refer to any other resources
or files.
■
Some resources reference other resources. For example, maps and layers are stored as separate
resources, and the map refers to the layers that are included in the map.
■
Some resources use associated resource data. For example, an ArcSDE feature source uses a string
that holds the database credentials. Resource data can be stored as files, streams, or strings.

Resources and data within the resource API structure
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Using Resource Service Sample Code
This Example shows how to download a file from the MapGuide repository on the server so you can
download it.

This example assumes that the Site Connection has already been set up.
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Feature, Mapping, Drawing, and Rendering Services
The Feature Service is an API that provides access to the FDO API. With the Feature Service API, you
can report on the feature sources that are available, find the capabilities of the feature source, find
out which storage technologies are available, and determine the structure of the source datastore.
Access to the storage technology is modeled as a connection. For example, you can connect to a file
and do simple insertions or connect to a relational database and do transaction‐based operations.
Insert, update, delete, select, and filter are some of the transactions that can be called with the
Feature Service API.

Using Feature Service (FDO) Sample Code

162

■

Chapter 5: Application Development

Mapping Service
With the Mapping Service you can display your data. It can create eMaps, designed for online viewing.
An eMap is a DWF™ file containing metadata about the image to be displayed. The DWF Viewer uses
this metadata, along with information about the current scale, center of the image, and size of the
browser window, to request image data from the Autodesk MapGuide Enterprise server. The Mapping
Service can also produce ePlots, which are designed for hardcopy printing.
The Mapping Service only supports Internet Explorer on Windows, since the DWF Viewer is only
supported on Internet Explorer on Windows. In order to use the Mapping Service, the site and
resource services must be available in your application.

Using Mapping Service Sample Code
Example code for using the Mapping Service to Convert a Map into a DWF

Drawing Service
The Drawing Service allows low‐level access to DWF data stored in a resource repository as part of a
drawing source.
It contains one class: MgDrawingService. DWF files contain:
■
An XML file, manifest.xml, listing information about the DWF.
■
A coordinate space.
■
One or more resources. These are typically design data in various formats (such as W2D, JPG, PNG,
AVI, and XML).
Typically the contents are organized into sheets, each of which represents a logical component being
published, such as a mechanical part or a page of a multipage diagram.
Each sheet may have a descriptor.xml file containing sheet‐specific metadata, and each sheet may
contain drawing layers.
The drawing service allows you to enumerate parts of the DWF, such as layers, sheets, and resources,
and to get the binary data from drawings, layers, and resources.
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Using Drawing Service Sample Code

Once the variable $byteReader has the XML document, you can parse the XML to
retrieve the information about the DWF, such as the Layouts (Sections).

Rendering Service
The Rendering Service renders a map into a bitmapped image for use in the HTML/AJAX viewer.
Rendering the map into an image, rather than using the drawing server (DWF), is recommended for
cross‐platform and multiple‐browser support.

Using Rendering Service Sample Code
Example code for using the Rendering Service to product a PNG version of the map:
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Exercise: Explore the Web Server Extensions API Help
In this exercise, you browse the MapGuide Web
API Reference. You will navigate various sections of
the site and view some of the example code that is
available. You will then use some sample code already
taken from the site and view in your browser.

3.

In the Security Warning dialog box, click Yes.

4.

In the MapGuide Web API Reference index,
expand the Modules group by clicking the plus
sign beside Modules.

5.
6.

Under Modules, click Maps and Layers.
In the left content pane containing the Maps
and Layers information, click the MgMap link.

The completed exercise

Explore the Web Server Extensions API Help
1.

2.

Click Start > Programs > Autodesk > Autodesk
MapGuide Enterprise 2010 > Web Server
Extensions API.
In the Internet Explorer window, right‐click the
yellow Security bar > Allow Blocked Content.
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7.

In the MgMap map page, click More...

10. Another key line to modify is right below the
first starting at: " // Initialize".

In order to find MapGuide's initialization file
with all the default ports, you would have to
change this line to:
MgInitializeWebTier('C:
\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions
\www\webconfig.ini');
11. Finally, scroll down to the line that starts with
" // Get a runtime map from a map definition".

8.

9.

In the MgMap Class Reference, there is an
Example (PHP) to show you how to get the
map from your MapGuide repository and print
out some details of the map.
■
Browse down to the line that begins with
"// Show information about the map"

The $map‐>GetName() function returns the
name of the map as a string.
Three key lines have to be changed for you to
use this code. Scroll up to the beginning of the
code that begins with: "//
Include constants like
MgServiceType::ResourceService"

Since the constants are installed in a different
location, this line would have to be changed to:
include 'C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions
\www\mapviewerphp\constants.php';
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In our case, this line would have to be changed
to:
$resourceID = new
MgResourceIdentifier('Library://
REDDING/5_MAPS/
REDDING_MAP.MapDefinition');
12. While still in Internet Explorer:
■
Scroll to the top of the page.
■
Click List of all Members.

13. Scroll down the page to view the functions that
were used in the previous PHP Example, such
as
GetName() or
GetSessionId().

2.

3.

Drag and drop mgMapExampleCode.php
into C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions
\www\ folder.
In Internet Explorer, in the address bar, enter:

Try Sample Code
Now you will try the sample code that is available in
the MapGuide Web API Reference.
1.

In Windows Explorer:
■
Browse to the C:\Projects
\MapGuide2010\mgweb\ folder.
■
Click mgMapExampleCode.php.
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Lesson: FDO, Viewer, and Studio APIs
In this lesson, the Server, Studio, and Viewer APIs are explored. The Autodesk MapGuide Enterprise
web server extensions open the FDO API so you can access your data and the structure of the
MapGuide Server. The Studio API enables you to automate your loading and authoring processes.
Finally, the Viewer API is a client‐side set of tools so you can customize your interface without
performing server‐side calls.

Three types of APIs in MapGuide Enterprise

Objectives
After completing this lesson, you will be able to:
■
■
■

168

Descibe the FDO API.
Describe the client‐side viewer API.
Describe the key namespaces in Studio API.
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FDO API
The Autodesk Feature Data Objects (FDO) API is a programming environment that provides an object
oriented API that you can use to customize AutoCAD and AutoCAD‐based products like AutoCAD® Map
3D and Autodesk MapGuide Enterprise.
The FDO API provides consistent access to feature data, whether it comes from a file‐based data
source or from a relational database that supports rich classification. To achieve this, FDO supports a
model that can readily feature the capabilities of each data source, allowing you to tailor consumer
applications functionality to that of the data source.
For example, some data sources may support spatial queries and long transactions, such as Oracle
Spatial, while others do not, such as SHP. Likewise, FDO includes a flexible metadata model to allow
clients to adapt to the underlying feature schema exposed by each data source.
Autodesk MapGuide Enterprise web extensions, using the feature service API, enable you to access
FDO through Autodesk MapGuide, so you can forgo using the direct FDO API. The direct FDO API
is an independent API for cross development with Autodesk MapGuide and AutoCAD Map 3D FDO
development.
AutoCAD Map 3D and Autodesk MapGuide Enterprise share the FDO. The FDO providers give the
same, direct, simultaneous access to multiple databases and files (including Oracle, ArcSDE, DEM, and
SDF).
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About Data Manipulation
The primary purpose of the FDO API is to have a standard method for accessing, analyzing, and
managing data among all Autodesk GIS products, such as AutoCAD Map 3D and Autodesk MapGuide
Enterprise.
With the FDO API, you can get the capabilities of the FDO data source that you connect with the FDO
provider. For example, performing ANYINTERACT functions is restricted to Oracle Spatial.
Once you have the capabilities of the data store, you can navigate its schema, or structure and storage
of the data. A schema is a logical description of the data types used to model real‐world objects. A
schema is not the actual data table (for example, the engineering department data and not a layer like
water mains). A schema is basically metadata of the data store.

FDO provider connecting to native datastores
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Filters and Commands
Much like the filters that you can use in the feature service of the web extensions API, the FDO API also
allows spatial filters. An SQL context can be applied to the FDO data source for filtering.
For example, a filter may be used to identify all road type features that have two lanes and that are
within two hundred meters of a particular location. Commands are those calls to the datastore to
trigger or activate an event or filter within that datastore. For example, a command may be used to
copy a feature or delete a layer.

Geometry
The following geometries are supported by the FDO API:
■
Point.
■
LineString (one or more connected line segments, defined by positions at the vertices).
■
CurveString (a collection of connected circular arc segments and linear segments).
■
Polygon (a surface bound by one outer ring and zero or more interior rings; the rings are closed,
connected line segments, defined by positions at the vertices).
■
CurvePolygon (a surface bound by one outer ring and zero or more interior rings; the rings are
closed, connected curve segments).
■
MultiPoint (multiple points, which may be disjoint).
■
MultiLineString (multiple LineStrings, which may be disjoint).
■
MultiCurveString (multiple CurveStrings, which may be disjoint).
■
MultiPolygon (multiple Polygons, which may be disjoint).
■
MultiCurvePolygon (multiple CurvePolygons, which may be disjoint).
■
MultiGeometry (a heterogeneous collection of geometries, which may be disjoint).
Geometry such as raster and ODBC points, and DEM datasets such GeoTIF and DEM
files, are also natively supported with the FDO API.
The FDO libraries in the Autodesk MapGuide Enterprise web extensions are a subset of the FDO API
found in AutoCAD Map 3D. Autodesk MapGuide Enterprise, combined with AutoCAD Map 3D, is a
complete enterprise solution for data creation, management, and publishing.
Also, more FDO libraries are available that are used in AutoCAD Map 3D as well. For full
documentation, visit http://fdo.osgeo.org.
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About the Viewer API
There are two key Viewer APIs:
■
Basic Web Layout Viewer API (JavaScript/VBScript)
■
Flexible Web Layout Viewer API (JavaScript/XML)

Basic Web Layout Viewer API
This neutral Viewer API that works with both AJAX and DWF Viewers. This API is a client‐side
Javascript/VBScript API that is loaded when the frames that surround the web layout is seen in
the browser. Within Basic Web Layout you can use the Viewer API to manipulate the map, create
customized buttons or trigger events to launch URLs.
There are some Basic Web Layout Viewer API calls that are used to pass information
to the server. The JavaScript API is created to call real‐time server requests, while still
using client side scripting. For more information, see the Viewer API document in
https://mapguide.osgeo.org/files/mapguide/docs/viewerapi/viewerapi.html.

Flexible Web Layout Viewer API
The Flexible Web Layout viewer is AJAX, much like the Basic Web Layout version, but has a different
architecture. The API is not the same as the Basic Web Layout. Although it still uses JavaScript on the
client, it also utilizes XML files as Widgets. These Widgets use a combination of XML, JavaScript and
some server‐side API in order to work.
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Basic Web Layout Viewer Frames
With the Basic Web Layout, the Autodesk MapGuide Enterprise AJAX and DWF viewers use HTML
frames in order to create the mapping interface. These frames are used to contain features such as the
taskfFrame, the toolbar and the map itself.
When using the Viewer API, it is important to understand how these frames work and what they are
named so that you can reference them in your code.

Basic Web Layout Viewer frameset

The Flexible Web Layout Viewer does not use frames.
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About HTML Frames
With frames, you can display more than one HTML document in the same browser. Each HTML page is
embedded within a frame. Each frame is completely independent but related to the others.
Frames are rectangular regions that contain an HTML page. Pages can communicate with each
other using JavaScript or VBScript provided they are from the same domain (for example,
www.autodesk.com).

Frameset Example
<frameset cols="40%,*">
<frame name="leftFrame" src="http://mapguide.osgeo.org">
<frame name="rightFrame" src="http://www.autodesk.com">
</frameset>

Two horizontal frames with mapguide.osgeo.org and autodesk.com
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About MapGuide Frames
MapGuide frames all have a specific purpose. Some frames contain the map while others contain the
toolbar. You can refer to these frames with JavaScript and the Viewer API as long as you know the
name of the frame.
Following is a list and a description of each frame in the MapGuide Viewer:
■
maparea ‐ Frame set containing the tool bar, map frame, form frame, and script frame.
■
tbFrame ‐ Frame containing the toolbar. Add new commands to the toolbar by modifying the web
layout.
■
mapFrame ‐ Frame containing the map data. This includes the map display, the layers, and
properties palettes.
■
formFrame ‐ Hidden frame that can be used to generate HTTP POST requests for sending data to
the server.
■
scriptFrame ‐ Hidden frame that can be used to load and execute pages without them being visible
to the user. This is often used for executing client‐side JavaScript.
■
taskArea ‐ Frame set containing the task bar and the task frame.
■
taskBar ‐ Frame containing the task bar.
■
taskFrame ‐ Frame used for displaying the task list. This is normally hidden, and is shown when a
user clicks the task list button in the task bar. Add new commands to the task list by modifying the
web layout.
■
taskPaneFrame ‐ Frame used for displaying and executing MapGuide pages. A web layout has a
default home page that displays in the task pane when the layout loads. Custom commands of
type Invoke URL also load in the task pane.
■
sbFrame ‐ Frame containing the status bar.
All frame names are case‐sensitive when referring to them in code. For example,
mapFrame is different from mapframe.
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Basic Web Layout Viewer API Frames
Some of the Viewer API functions are stored in certain frames. Each frame represents a different
aspect of the MapGuide Viewer. In the topmost frame, there are a number of functions that
enable you to retrieve the frame you want without having to know the hierarchy of the frames.
In JavaScript or VBScript, to retrieve the very top frame, you may use parent.parent.mapFrame or
top.parent.ScriptFrame as part of the hierarchy.
The following list of top frame retrieval functions uses this technique:
■
parent.parent.GetMapFrame()
■
parent.parent.GetFormFrame()
■
parent.parent.GetScriptFrame()
■
parent.parent.GetTaskFrame()

Example of Using Basic Web Layout Viewer API with Frames
Often a user wants to zoom to a specific scale. To use the Viewer API to zoom to a scale, you can use
a function called ZoomToView(). The ZoomToView(x, y, scale, refresh) function requires the X and Y of
the current map in the correct coordinate system, the scale, and a flag to let the map know if it should
refresh.
To get the the X and Y, two more functions would be required. The GetCenter() has an X and Y
property but the GetCenter() function is in the mapFrame and not in the main frame, so you have to
use the GetMapFrame() function as well.
To put it all together, the javascript would look like the following:
var myMapFrame = parent.parent.GetMapFrame();
var X = myMapFrame.GetCenter().X;var Y= myMapFrame.GetCenter().Y;
parent.parent.ZoomToView(X,Y,10000,'true');
Once you have this javascript, you can paste it into the Invoke Script tool in Autodesk MapGuide
Studio to use.

Viewer API Invoke Script in Basic Web Layout
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Flexible Web Layout Viewer API
Completely separate from the Basic Web Layout Viewer API, the Flexible Web Layout Viewer API
comprises mostly of XML and associated Javascript to create Widgets. In Flexible Web Layouts, the
MapWidget is central to all development. The MapWidget is the primary interface between the
application and the spatial data represented by the map.

Flexible Web Layout Architecture
Flexible Web Layout customization relies on the MapGuide component that creates a web mapping
application by combining an Application Definition and a Map Definition with an HTML web page
(called a Template). These HTML Templates can be customized (such as the Maroon or Slate
templates).
Code can be added directly to the index.html page, called a Template, or it can put into a Widget as a
combination of XML and JavaScript.

Flexible Web Layout Architecture

A Flexible Web Layout Widget is similar to an object in the Basic Web Layout. The difference is that the
Toolbars, Overview Map, and even the Map itself, can be customized with the XML/JavaScript Widget
where as the Basic Web Layout can only be customized in a very simple way within MapGuide Studio.
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Example of Template (HTML) Flexible Web Layout API
The following image demonstrates how the Flexible Web Layout API is used within the index.html
page of the Maroon Web Layout Template to show the names of the layers in the map.

JavaScript Code for Flexible Web Layout

About the Studio API
The Autodesk MapGuide Studio API provides Autodesk MapGuide Studio the ability to manipulate
data, layers, maps, web layouts, print layouts, and symbol libraries. The API uses the Studio
installation files so Autodesk MapGuide Studio must be installed on the same computer as the code
for the API.
Since the API also uses the Microsoft .NET Framework, the main development environment will be
VB .NET or C# .NET. Most of the examples will be in C#. Microsoft Visual Studio is recommended, but
you can always use the Microsoft Visual C# or Visual VB Express Editions, which are free to download
from Microsoft. The Studio API Help is installed when Autodesk MapGuide Studio is installed.

MapGuide Studio Help lInk

Autodesk MapGuide Studio has two key areas or namespaces:
■
Autodesk.MapGuide.Studio.Site
■
Autodesk.MapGuide.Studio.Load
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About the Autodesk.MapGuide.Studio.Site
The Site namespace provides the means to access and modify the Autodesk MapGuide resource
repository located at a specific Autodesk MapGuide site.
As with Autodesk MapGuide Studio, the Site is connected to by providing the URL of the site and
passing the username and password.
The SiteManager class enables you to connect to Autodesk MapGuide site as a specific user. You will
create a SiteConnection and you must always use this SiteConnection to access any resource on the
Server. For example:

The resources in the repository are accessed using the same folders that are seen in Autodesk
MapGuide Studio (for example, Library://Redding/2_DATA/). To access a folder you can use the
FolderInfo class.

A resource is represented by an instance of the ResourceInfo class. ResourceInfo has a number of
subclasses, depending on the type of resource. For example, the FeatureSourceInfo class represents a
feature source resource; the LayerInfo class represents a layer resource, etc.
For example, to get the feature source view that provides the resources that are referenced by that
layer (for example the map definition and load procedure):

All resources, regardless of the resource type, are stored in the repository using XML documents.
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In order to manipulate the XML, you must be able to use the XMLDOM and parse
the XML with code. Consuming XML is a pivotal part of manipulating the resources in
Autodesk MapGuide Studio API.

About Autodesk.MapGuide.Studio.Load
With the Load namespace, you can convert a number of file formats into one of the file formats
supported by Autodesk MapGuide Enterprise including:
■
DWG™
■
DWF
■
SDF
■
SHP
■
Raster
To convert a file, you use an instance of LoadProcedure class. This class has one subclass for each type
of file that can be converted such as:
■
DwfLoadProcedure
■
DwgLoadProcedure
■
SDFLoadProcedure
■
SHPLoadProcedure
■
RasterLoadProdure
In order to retrieve Block Attributes, Object Data, or Link Template information from
the DWG, the DWG must be classified prior to conversion with Autodesk MapGuide
Studio or with the Studio API.
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The LoadProcedure class uses some of the classes in the Site namespace in order to add files to a
MapGuide resource repository.
Loading data using the Autodesk MapGuide Studio API is almost as simple as using Autodesk
MapGuide Studio itself. For example, if you wanted to load a DWG file stored on your computer to the
Autodesk MapGuide Enterprise site, the following code could be run:

Finally, if you have already defined your connection to the site, you can load the file to the server:
The execute command can optionally have the local path for the package (MGP) file, such as:

A Sewer.MGP file will be left in the folder. When the execute method is run, a temporary MGP file is
created, but if you enter the full path where you want the MGP file placed, you can retain a copy.
If you rename a MGP file to a ZIP, you can view the package and associated XML and
SDF or DWF files using Windows or WinZip.
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Introduction to Load Procedures/Batching
You can call load procedures when moving any data to the server, just like you can within MapGuide
Studio directly. If you want to run a pre‐existing load procedure, you must read the LoadProcedureInfo
information using the site namespace and parse the XML, extracting all the pertinent information
about the load. Then you programmatically rebuild that load with the Load namespace and the
LoadProcedure(s).
The easiest way to programmatically load data multiple files is to use a batch file. A batch file (*.BAT)
is a text file that contains a sequence of commands. Batch files can store sets of commands that are
always executed together. Then you can enter the file name of the batch file instead of entering each
command individually.
One way to use a batch file is at the command prompt. The command prompt is a window displayed
on the desktop where you enter commands that interface with the MS‐DOS operating system. You
display the Command Prompt window by clicking Start > Programs > Accessories > Command Prompt.
One advantage of using batch files is that Microsoft Scheduled Tasks can be run to
keep the data up‐to‐date without any human interaction.

LOADDWG.bat in Windows Scheduled Tasks
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DWG Load With Command Line Arguments
To create a batch file, the executable you create must be able to accept arguments from the command
line.

You will have to create your own switches or command line arguments that store your variables. In the
example above, the /SUBSAMPLE: is a switch with a value of 25.
In the following C# example of loading DWG files using batch files, the following switches are created:
/RTFLD:

The root folder for the load on the MapGuide server (for example, “Library://
Redding/”)

/DATAFLD:

The folder where the data repositories are stored (2_DATA)

/LYRFLD:

The folder where each layer is stored (3_LAYERS)

/MAPFLD:

The folder where the maps are stored (5_MAPS)

/SYMFLD:

The folder where the symbol library is stored (4_SYMBOLS)

/MGUSER:

The MapGuide Server login (Administrator)

/MGPASS:

The MapGuide Server password (admin)

/MGSITE:

The MapGuide Server Site URL (http://localhost/mapguide2009)

These switches can be called anything you want; they just store the variables passed
in the command line interface.
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In order to use these switches, you have to be able to catch the arguments in the executable (for
example, string[] args), and then parse each argument in a variable:
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Now that you have all the command line arguments, you can load the DWG as demonstrated earlier:

This code is extremely simple and does not contain any error checking or string
validation.
Once compiled, the executable can now accept all the switches contained in the batch file. For
example, the batch file may look like the following:

This batch file can be run using the Window Scheduled Tasks to keep the server up‐to‐date with the
latest DWG information.
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Lesson: Choosing Your Development IDE
In this lesson, you explore the need for an IDE (Integrated Development Environment).

Microsoft Visual C# IDE

Objectives
After completing this lesson, you will be able to:
■
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Descibe the key components of an IDE.

■

Chapter 5: Application Development

IDEs
An IDE (Integrated Development Environment) is an application with which you can develop your
applications in one place. Usually, you can author, edit, compile, debug, and deploy your application.
There usually would be a suite of tools, wizards, and built‐in auto‐complete and code validation tools
to help you create your applications. Working in an IDE gives you all the necessary help to write your
code. For example, you may not have memorized all the methods within a particular language, but if
you type the name of an object in the IDE, the methods may appear as a list automatically.
Prior to the IDE, many programmers (and some still) use command‐line interfaces or simple text
editors to develop code. Many web pages and Java applets have been created within programs such as
Notepad in Windows or VIM in Linux. Although there are some tools for spell checking or searching by
line numbers in these programs, it can be argued that these are not IDEs.
Most components are common to standard IDEs:
■
Edit window
■
File explorer
■
Object browsers
■
Debug window
■
Code snippet and wizards
■
Color coding of text in edit window
There are many IDEs for PHP such as BlueFish for Linux. A more complete list of PHP Editors can be
found at www.php.net.

IDE must Match Autodesk MapGuide Web Server Extension
Regardless of the development environment and the version of the Autodesk MapGuide Enterprise
web server extensions you choose, the IDE and language must match the web extension. For example,
if you choose to work with the .NET Web Server Extension, you then must also use a .NET IDE such as
Microsoft Visual C# Express or Visual Studio.
You can always use a generic text editor for developing your ASP .NET, PHP, and JSP code. The
advantages of using an IDE will be seen as you develop larger applications and complex sites that
require rapid development and intensive debugging tools.
The Basic Web Layout Viewer and Flexible Web Layout Viewer both use JavaScript.
Although the IDE you choose may be very good for the Web Extension such as
PHP, .NET or Java/JSP, you may wish to try an IDE that is specifically for JavaScript
development.
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Example PHP IDE
One example of an IDE for PHP is called PHP Designer.

PHP Designer

Microsoft .NET IDEs
There are a number of .NET IDEs available. The most commonly used, by far, is Microsoft Visual
Studio. You can use this interface to develop ASP.NET applications in either C# or VB. Another IDE
for .NET is the free Microsoft Visual Web Developer 2008 Express Edition, which is a limited version of
Visual Studio. More express editions of Visual Studio include the Visual C#, Visual VB, and Visual C++
Express Editions.
In addition, Macromedia Dreamweaver supports both ASP .NET and PHP environments.
The MONO Project is an initiative to put .NET in a Linux environment using C# Microsoft libraries. The
IDE, MonoDevelop, is a Linux‐based IDE that connects with the MONO Project libraries.
Another IDE that is open source is the Sharp Develop (#develop) IDE that supports C# and VB.NET
projects.
With any IDE for .NET, the Microsoft .NET Framework must be installed. The
Autodesk MapGuide Enterprise web server extensions for .NET must be installed as
well.
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Java IDEs
The Java environment has many IDEs even though many developers still use products such as
TextPad and compile at the command line. One popular IDE for Java is an open source application
called Eclipse. There are many commercially‐packaged versions of Eclipse, such as BEA M7. Borland
also offers an IDE for Java called JBuilder. Oracle has its own JDeveloper 10g, with all the tools and
connections to native Oracle.

Java IDE showing JSP files for MapGuide
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Chapter Summary
Having completed this chapter, you can:
■

■
■
■
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Decide how to choose the MapGuide Enterprise Web Server Extension and development
language.
Explain the purpose of the Web Server Extensions API.
Explain the difference between the FDO, Viewer and MapGuide Studio API.
List the advantages of using an Integrated Development Environment (IDE).
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Chapter

6
Report Development
In this chapter, you learn the basic components of PHP scripting using Autodesk MapGuide® Enterprise
Web Server extensions. This chapter introduces you to techniques for launching reports using the Web
Layouts from within MapGuide Studio.

Objectives
After completing this chapter, you will be able to:
■

Develop an application for reporting with PHP using the Web Server Extensions API.
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Lesson: Developing Reports
This lesson shows how to use PHP code to launch a report from a database from MapGuide Viewer.
The lesson also covers an introduction to PHP and MapGuide API calls.

Lauching a Report from MapGuide

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
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Explain the basic code structures in PHP.
Describe the process of creating HTML forms and reports with PHP.
Create a web alias.
Connect to ODBC with PHP.
Create a PHP report.

■
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PHP Basic Components
PHP is similar in style to JavaScript or C, so if you are already a developer or have done some
programming previously, you will find PHP a simple language to learn. For new developers, this
overview will be a good start to building advanced applications with PHP and Autodesk MapGuide
Enterprise.

Basic Syntax and Variables
PHP code is wrapped with the PHP tags. These tags delineate which code is going to process on the
server before being sent to the browser as standard HTML.

Even though the variables are defined when they are assigned a value, they are still defined distinctly
and not as a variant. For example, you cannot multiply two variables that are defined as strings. The
following is list of types of variables:
■
String (any text values)
■
Integer (discrete numbers like 1,2,3)
■
Double (floating point decimal 23.332)
■
Boolean (True or False, Yes or No, 1 or 0)
■
Array (Ordered map of data within the variable – any type)
■
Object (Type with Properties and Methods)
For example, in the same order as variables above:

Variables always have the dollar sign ($) preceding the variable name.
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Loops and Conditions
Looping is extremely important when working with arrays or lists. To loop over an object's collection is
often required in Autodesk MapGuide Enterprise.
Some examples of three types of loops (do‐while, while, and for):

These are the conditions in PHP.
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Condition

Result

$a == $b

Equal

$a != $b

Not equal

$a <> $b

Not equal

$a < $b

Less than

$a > $b

Greater than

$a <= $b

Less than or equal to

$a >= $b

Greater than or equal to

■
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IF and Switch Conditions
When developing an application, you always need to use logical conditions such as the IF and Switch
statements. For example, if the user is a “guest,” then a variable would be set to show that. If the user
is an “Administrator,” then the variable would be set to something else. This example shows IF and
Switch conditions:
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PHP Database Reports: ODBC Example
In this example, PHP is used to connect to a sample ODBC database in Windows.

The echo statements print the results to the HTML page after the PHP code is
processed on the server and the odbc_fetch_row() function iterates through the
resulting record set.
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Also, you should note that this previous example uses an ODBC connection on the server. If you want
to use an ODBC DSN‐less connection, you can connect with a connect string instead as seen below.

There are many database functions that can be utilized in PHP including Oracle, Microsoft SQL Server,
PostgreSQL, MySQL, and others. For a list of functions see www.php.net.

PHP Forms and Reports
PHP uses generic HTML in terms of its data entry. Forms are widgets within a web page that enables
the user to enter information.
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PHP Forms
The following demonstrates how to send information from a form to a PHP page.
1.

In this case, you first have to create the
HTML form to send the information.

2.

Next, create a PHP page to catch the
contents of the txtSend text box using the
$_REQUEST["elementName"] method:

Since you can use either POST or GET for the forms, you can use the $_GET and $_POST methods to
retrieve the values that were sent to the PHP page.
If you want to use the generic $_REQUEST variable, as was done above, this will retrieve both the
POST and GET variables.

Multiple Select with PHP and Forms
When selecting multiple records in a SELECT drop‐down, be sure to add the square braces [ ] to the
name of the select box.
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Parsing the Multiple Select in PHP
Once the multiple select has been passed to the PHP page, you will need to loop over the selGISID and
put commas between each ID. Note that the extra comma is removed from the end of the list.

Write PHP Reports
In Autodesk MapGuide® Studio, if you are using the Basic Web Layouts, you can create an Invoke URL
script that would launch the URL with the associated XML variable containing the internal MapGuide
IDs stored in XML passed as the $CurrentSelection parameter.
For example, the http://localhost/mgweb/reports/parseMapGuideXML.php can be launched from
the shortcut menu if the user selected the parcels layer. This URL would receive the URL parameters ?
OBJ_KEYS_XML=xml‐of‐selected‐features when the user clicked this button in the Autodesk MapGuide
Viewer.
Another method, used by server‐side API, available for the Basic Web Layout with AJAX and
Flexible Web Layouts is the ability to send the user's MapGuide Session ID to the API to extract the
properties of the selected features. This method is entirely server‐side and requires no XML from
the client. The pivotal API that enables this selection is the method of the MgSelection object called
GetSelectedFeatures().
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InvokeURL
InvokeURL is used to launch a Web page that parses the MapGuide parameters. The MapGuide
session, Map name, and selected features are passed to a URL. The URL parses the selected features
XML ($CurrentSelection) and translates them into usable keys or IDs.

InvokeURL in Flexible Web Layout
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Exercise: Create a Web Alias
In this exercise, you create a "virtual directory" or
alias to your C:\Projects\MapGuide2010\mgweb\
folder so that you can call any Web pages placed in
that folder.

4.

In the httpd.conf file:
■
Scroll to the bottom of the document.
■
At the bottom of the document, enter:
Alias /mgweb "C:/Projects/MapGuide2010/
mgweb/"
■
Click File menu > Save.
■
Close httpd.conf.

5.

Open Control Panel > Administrator Tools >
Services.
In the Services dialog box:
■
Click ApacheMapGuide2010.
■
Click Restart Service.
■
Close the Services dialog box.

The completed exercise

Create a Web Alias
1.
2.
3.

Open Programs > Accessories > Notepad.
6.
In Notepad, click File menu > Open.
In the Open dialog box:
■
Browse to C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions
\Apache2\conf\.
■
Change the Text Documents (*.txt) to All
Files (*.*).
■
Click httpd.conf.
■
Click Open.

You have successfully created a web alias that will
open files in the C:/Projects/MapGuide2010/mgweb/
folder.
For example http://localhost/mgweb/ will now point
to that folder and any html documents within it.
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Exercise: Create an ODBC Connection to the MS Access
Exercise: Database
In this exercise, you set up an ODBC connection to
point to the MS Access file. This step is important, as
the PHP page will use ODBC to access the database.

3.

In the Create New Data Source dialog box:
■
Select Microsoft Access Driver (*.mdb).
■
Click Finish.

4.

In the ODBC Microsoft Access Setup dialog
box:
■
For the Data Source name, enter:
redding_odbc.
■
Click Select.
In the Select Database dialog box:
■
Browse to C:\Projects
\MapGuide2010\Database
\Autodesk_Redding_Dataset.mdb.
■
Click OK.
To close the ODBC Microsoft Access Setup
dialog box, click OK.

The completed exercise

Create an ODBC Connection to the MS
Access Database
1.

5.

Open Control Panel > Administrator Tools >
Data Sources (ODBC).
6.

2.
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In the ODBC Data Source Administrator:
■
Click the System DSN tab.
■
Click Add.
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7.

To close the ODBC Data Source Administrator,
click OK.
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Exercise: Create a PHP Report
In this exercise, you review an existing PHP report
that provides information about the selected parcels.
APN, address, and land values will be displayed in the
report. You open a pre‐existing PHP report and view
its contents step‐by‐step.

2.

In Notepad:
■
Click File menu > Open.
■
For Files of Type, select All Files.
■
Browse to C:\Projects
\MapGuide2010\mgweb\.
■
Select parcel_report.php.
■
Click Open.

3.

You connect to the ODBC connection that you
created earlier. If the connection fails, throw
an error.

4.

Create a string called $sql that contains the
SQL statement that queries the database with
the OBJ_KEYS sent from the other page. The
$rs is the recordset containing the resulting
records from the SQL query.

You will view an intermediate page that can be used
for any kind of report, regardless of language. This
page is called invokereport.php. This PHP page was
created to parse the internal MapGuide Keys of the
selected objects and send them to your pre‐existing
report. This invokereport.php works with Flexible
Web Layouts and Basic AJAX Layouts, since both use
AJAX server‐side selections.
You use two files in this exercise: parcel_report.php
and invokereport.php.
Once the APN keys are parsed out inside
the invokereport.php, they are passed to
parcel_report.php to run a report from a Microsoft
Access database.
At the end of this exercise you open the Flexible Web
Layout in a browser and launch this parcel report
from the map.

The completed exercise

Review an existing PHP Report ‐
parcel_report.php
1.
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Open Programs > Accessories > Notepad.
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5.

6.

7.

Set up a simple 3 by 2 table, with the 3
columns that you are querying.

11. In Internet Explorer, in the Address bar, enter:
http://localhost/mgweb/parcel_report.php?
OBJ_KEYS='101040029000'

Note: You are using PHP's echo to send the
HTML directly to the browser.
Loop over each record in the recordset using
the odbc_fetch_row() function in PHP.

Retrieve four columns from the database: APN,
ADDRESS, STNAME, and LAND_VALUE.
Format the ADDRESS so that the street
number does not have decimal places and the
LAND_VALUE has two decimal places, with the
number_format() function in PHP.

Review the invokereport.php
The invokereport.php is a report designed to extract
the selected objects using the MapGuide Server API,
filter out the attributes required, and post them to an
existing report.
In this case, the selected parcels will have the APN
property extracted and passed to the report. This
report is completely server‐side and will not work
with the Basic DWF VIewer.

8.

9.

Echo the four variables to the screen.
1.
2.

Note: There is now an extra dollar sign beside
$LAND_VALUE.
Close the ODBC connection and then finish the
table outside of the while() loop.

3.

Open Programs > Accessories > Notepad.
In Notepad:
■
Click File menu > Open.
■
For Files of Type, select All Files.
■
Browse to C:\Projects
\MapGuide2010\mgweb\.
■
Select invokereport.php.
■
Click Open.
Make sure that you have the configFilePath
set to the installed directory for the
WebServerExtensions.

10. Close Notepad.exe.
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4.

Five parameters are sent to this report:
■
SESSION ‐ SESSIONID sent from MapGuide
Viewer
■
MAPNAME ‐ Map Name sent from
MapGuide Viewer
■
LAYER ‐ Layer Name that the report is
based on ‐ sent from the InvokeURL
■
URL ‐ Name of the report
(parcel_report.php) sent from the
InvokeURL
■
METHOD ‐ POST or GET ‐ Sent from
InvokeURL in MapGuide Studio

5.

The Web Server Extensions are initialized and
two key services are created:
■
Resource Service
■
Feature Service

6.

You get a copy of the map based on the user's
current connection. Then you get what the
user selected. Finally, you get all the layers of
the selected objects.
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7.

Although you are running a parcel query,
the user can select many features on map.
You will have to loop through all the layers
of the selected features (stored in the
$featureReader variable) and filter out the
features based on layer name (for example,
Parcels).

8.

Loop over the features, creating a comma
delimited list of keys called $objkeys. The value
is concatenated with a dot in PHP. The APN
property in the Parcel.shp file is checked for
type. In this case, the type of the APN property
is a string (case 9).
If a number of parcels are selected,
the $objkeys variable might look like
'101040029000','101040031000'.

9.

Finally, the results of the query are exported
into an HTML FORM and then automatically
submitted using JavaScript when the page
loads in the browser.
The form contains:
■
The URL for the report ‐ parcel_report.php
■
The Method ‐ POST or GET
■
The OBJ_KEYS ‐ based on the PHP variable
$objkeys
Note: Since the Hidden form object is called
OBJ_KEYS, the final report must be expecting
this parameter.

3.

In the Web Layout Editor, under Configure
Components of the Selected Template, click
Map:Right‐click Menu tab.

4.

Under Components Available in this Layout,
click New.
In the Create a New Component Based on a
Master Type:
■
Select Invoke URL.
■
Click OK.

5.

10. Close Notepad.exe.

Create an InvokeURL in the Flexible Web
Layout
1.

If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

2.

In Site Explorer:
■
Under the \REDDING\ folder, select
7_FLEXIBLE_LAYOUTS folder, select
REDDING_FLEXIBLE_LAYOUT.
■
Right‐click Open.
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6.

7.
8.
9.

Under Parameter for Select Item:
■
For ID enter: PARCEL REPORT
■
For Label to Display in the Interface, enter:
PARCEL REPORT
■
For Tool Tip to Appear on Hover, enter:
PARCEL REPORT
■
For Description to Appear on the Status
Bar, enter: PARCEL REPORT

For URL to Invoke, enter: /mgweb/
invokereport.php
Under Pass in These Additional Parameters
with the URL, click Add four times.
Under the list of keys:
■
For Key, enter: KEY
■
For Value, enter: APN
■
For the second item, for Key, enter: URL
■
For Value, enter: /mgweb/
parcel_report.php
■
For the third item, for Key, enter: LAYER
■
For Value, enter: Parcels
■
For the last item, for Key, enter: METHOD
■
For Value, enter: POST

10. Under Use Only These Layers, click Browse.
■
In the Select Layers dialog box:
■
Check Parcels.
■
Click OK.

11. Make sure that Disable Command If Nothing Is
Selected is checked.
For Target, select New Window.

12. In the Components Available in this Layout,
drag the PARCEL REPORT into Items Displayed
in Container.

13. Click File menu > Save
REDDING_FLEXIBLE_LAYOUT.
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14. In the Web Layout Editor, click View in
Browser.
15. In the Connect to Localhost dialog box:
■
For User Name, enter: Anonymous
■
Click OK.
16. Zoom into the map until the parcels layer is
available and select a few parcels.
This process of retrieving a set of keys from the
spatial data and passing them to a third‐party
report demonstrates that any sever‐side reporting
application can be used.
In fact, if you are using IIS, you may choose to use the
parcel_report.aspx in this exercise to demonstrate
how the invokereport.php can pass the parameters to
any type of report.

Note: You may wish to turn off the Zoning layer
to make selection easier.
17. Within the Map:
■
Right‐click.
■
Click PARCEL REPORT.

The Parcel Report is displayed.
(invokereport.php extracted the APN
properties from the selected parcels and sent
them to parcel_report.php.)
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Chapter Summary
Having completed this chapter, you can:
■
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Develop an application for reporting with PHP using the Web Server Extensions API.
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Chapter

7
Scalability
In this chapter, you learn three methods to increase the performance of your MapGuide site.Server
performance is introduced and youlearn to differentiate between a web farm and a customized
Autodesk MapGuide® Enterprise implementation for performance. You also learn how to use Autodesk
MapGuide® Studio to improve performance of the maps themselves. Finally, you learn how to manage
the data to optimize the searching, rendering, and querying of spatial and nonspatial data.

Objectives
After completing this chapter, you will be able to:
■
■
■

Describe the MapGuide Server performance tools.
Use MapGuide Studio to increase performance of the maps and layers.
Descibe how to structure spatial and non‐spatial data to increase performance in MapGuide.
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Lesson: Server Performance
In this lesson, you learn how to improve performance of the Autodesk MapGuide Enterprise Server.
The performance of Autodesk MapGuide Enterprise can be affected by the server‐side configuration.

Objectives
After completing this lesson, you will be able to:
■
■
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Explain how to configure pragmatic and site/support load balancing.
Describe Techniques for increasing MapGuide Server performance.

■
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MapGuide Server Performance
Web Server Farm
One of the most effective ways to improve server‐side performance is to use a server farm or web
farm. A server farm is a set of servers that are located in one location usually in a rack‐mount or
Blade server. A server farm distributes the workload among the individual computers within the farm.
This distributed model will increase the speed and efficiency by spreading the load among multiple
processors. Load balancing divides the amount of work that a server has to do between multiple
computers. Load balancing can be done with hardware, software, or a combination of both. One of
the major reasons to set up a web farm is for its robustness. If one of the servers in the farm fails, the
others help with the data loads.

Web farm

The web farm or server farm is completely independent of Autodesk MapGuide Enterprise but
Autodesk MapGuide definitely benefits from such a structure.
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About Pragmatic Load Balancing
Pragmatic load balancing (or loading) is an efficient load balancing mechanism of Autodesk MapGuide
Enterprise that enables the MapAgent to point to multiple mirrored or distributed MapGuide site
servers. The MapAgent has the capability to retain session affinity, simplifying the load balancer
configuration. As a result, each web tier deployment is able to make use of all of the available
MapGuide site servers.

Pragmatic Load Balancing Architecture
The following image demonstates how two MapGuide Servers and assoiciated MapGuide Web
Extensions can be used. All requests are sent to the primary Web Extension. Since the webconfig.ini
on the primary eb server contains the IP of the other server, the request is then sent to either server
based on use.

Pragmatic Load Balancing Architecture
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Set Up Pragmatic Loading
In a deployment that uses multiple, synchronized MapGuide site servers, a load balancer is typically
used to distribute incoming client requests to a number of MapGuide web server extension
deployments. Autodesk MapGuide Enterprise now provides a practical way of accommodating and
redirecting requests to any of its available web server extension deployments. This method does not
extend the services to support servers but relies on duplicate site servers to manage the load.
In pragmatic loading, the load balancing is driven by the web server extensions rather
than the service. The webconfig.ini file found in the C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions\www\ folder will have to be modified. Simply add,
with commas, the additional IP addresses of the duplicate servers inside this file and restart the server.
IpAddress = 192.168.166.109, 192.168.166.106

Webconfig.ini for Mulitple Servers

When using the Pragmatic Loading approach, be sure to replace the 127.0.0.1
that is recorded in the servercofig.ini file found in theC:\Program Files\Autodesk
\MapGuideEnterprise2010\Server\Bin\ folder with the true IP of that server.
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Advantage of Pragmatic Loading
Built‐in load balancing makes the process of configuring a load balancer quite simple. Simple load
balancing configuration results in an efficient distribution of the request load, which in turn results in
faster response times.

About Site Administration
The Autodesk MapGuide Enterprise Site Administrator is a web‐based interface and is used to manage
the site server. Within the Site Administrator, the additional servers can be modified and managed
from the one site.

Choosing IP of MapGuide Sever in SIte Administrator

Example of Pragmatic Loading
Consider a MapGuide deployment consisting of 3 servers, Site Server A, Site Server B, and Support
Server C. A client request from the MapGuide Viewer is received, and thus, a session is created on Site
Server A. The Site Server A's IP address is extracted and decrypted from the session ID and matched to
the one configured in the web tier for connection to that site server. The load balancer has the option
to direct the requests to Site Server B. Support Server C, if it requires access to session resources,
would be able to retrieve those session resources from either Site Server A or Site Server B, whichever
site server created the session for the request.
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Configuration for Performance
There are a couple of ways to increase performance of the server. By tweaking the MapGuide Server
and Web Extensions configuration files, you can increase the speed at which the server provides
information.

MapGuide Server Configuration File

Ways to Speed up the MapGuide Server
The following list describes small changes that can have big results to your Mapguide performance:
■
For the Basic Web Layout, you can increase the performance, but reduce the map resolution by
changing the default AJAX map to be PNG8 or JPG rather than the current PNG.
Change this setting in the file called ajaxmappane.templ in the C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions\www\viewerfiles/ folder.
Change the line that reads:
?OPERATION=GETDYNAMICMAPOVERLAYIMAGE&FORMAT=PNG&
To read:
?OPERATION=GETDYNAMICMAPOVERLAYIMAGE&FORMAT=JPG&
■
For the Flexible Web Layout, you can also reduce resolution but increase performance with JPG
and PNG8 that the viewer uses for the map rather than PNG.
Change the setting in the OpenLayers.js file found in the C:\Program Files\Autodesk
\MapGuideEnterprise2010\WebServerExtensions\www\fusion\lib\OpenLayers\ folder.
Change the code that reads:
SINGLE_TILE_PARAMS: { operation: 'GETMAPIMAGE', format: 'PNG',
To Read:
SINGLE_TILE_PARAMS: { operation: 'GETMAPIMAGE', format: 'JPG',
■
You can increase the memory that the MapGuide Server utilizes by increasing the Cache Size. To
calculate the cache size, multiple the number of layers in your map by 3. For example, if you have
50 layers in your map, you cache size should be 150. The cache size is stored in the serverconfig.ini
file in the C:\Program Files\Autodesk\MapGuideEnterprise2010\Server\Bin\ folder.
Change the line that reads:
CacheSize = 100
To Read:
CacheSize = 150
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You can increase the data connection pooling, which enables MapGuide Server to use existing
connections to feature sources in memory, which increases performance. This technique may lock
some feature sources and may require a re‐start of the server to unlock the files during data loads
or package creation.
Within the serverconfig.ini file, change the lines that read:
DataConnectionPoolSize = 200DataConnectionPoolExcludedProviders =
OSGeo.SDF,OSGeo.SHPDataConnectionPoolEnabled = 0
To read:
DataConnectionPoolSize = 200DataConnectionPoolExcludedProviders = none
DataConnectionPoolEnabled = 1
The ConnectionPoolSize should be the same number of Feature Sources you have on the server. Do
not Exclude and providers so that all connections, including SDF and SHP are pooled.

These techniques are to be used cautiously, as they may affect the resolution and/or daily update of
your mapping information.
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Lesson: Studio Performance
In this lesson, you learn some techniques in Autodesk MapGuide Studio to improve performance of
your site. Through data manipulation, authoring, and stylizing techniques much of the performance of
Autodesk MapGuide Enterprise is performed by the MapGuide Studio user.

Generalizing vectors in MapGuide Studio

Objectives
After completing this lesson, you will be able to:
■
■
■
■
■
■

Describe how scale ranges affect performance.
Explain how vector data is generalized.
Describe the uses for sub‐sampled raster images.
Explain how to increase the performance of AJAX based maps.
Create a scale range.
Generalize a vector layer.
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Scale Ranges
A scale range specifies the zoom level at which a particular style is applied to the display of your data.
When the zoom level of Autodesk MapGuide Studio or the viewer is within the specified scale range,
MapGuide Studio redraws the layer as specified by the style associated with the scale range.
Not only does the style change based on scale, but the scale also determines how much data is
downloaded to the viewer. For example, if you had road data for all of North America, which is
approximately 200 gigabytes of information, you may not want to turn that layer on at a small scale.
The best way to manage this information would be to assign a more reasonable scale, say 1:250,000,
to render that information.
Adjusting the scale at which a particular layer appears, regardless of whether it was file‐based (for
example, SDF or TIFF) or data connection (for example, Oracle Spatial), is extremely effective in
increasing the speed and performance at which a layer appears to the user with Autodesk MapGuide
Enterprise Viewer.

Scale range 1:10,000 for Raster layer
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Generalize Vectors
Scale ranges show layers at scales that are appropriate for the amount of data requested. Sometimes,
you want to show layers but the data is too rich to see at that smaller scale. For example, previously
you have set the parcels layer to only turn on at a scale of 1:25,000, but you may want to see the
parcels at a smaller scale.
For vector data that can be loaded or transformed, such as SHP, SDF and DWG™, there are tools to
generalize the data so that the file is smaller and details are simpler. Generalizing vector data reduces
the number of points, or vertices, used to represent a line.
Generalizing data reduces the size of the files that Autodesk MapGuide Enterprise server must transfer
to the client. When you generalize vector data, lines are eliminated as the number of vertices is
reduced.

Example of Generalized Data
File Name

Size

US_ROADS.SDF (original)

10 Gbytes

US_ROADS_75.SDF (75 Percent Generalized)

2.5 Gbytes

US_ROADS_95.SDF (95 Percent Generalized)

500 Mbytes

Configure Maps to Use Generalized Data
You can then set up maps so that you use a generalized version of data when zoomed out and the
original version when zoomed in. You will create two map layers created from the original data. On
the small‐scale layer, use the generalized data, and set the scale range so that the layer displays when
zoomed out. On the large‐scale layer, use the original data, and set the scale range so that the layer
becomes available when zoomed in to the point where the first layer stops.
For example, you may want to show a generalized road data from 1:250,000 to Infinite Scale and
then show the original road data from 0 to 1:250,000 scale. This would significantly increase the
performance of the maps and also ensure that there is always road data available to your users of the
Autodesk MapGuide Enterprise Viewer.
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Generalize within Autodesk MapGuide Studio
To generalize vectors in Autodesk MapGuide Studio, you have to set the Generalize percentage when
performing a data load procedure of the file.

Generalizing vectors in MapGuide Studio

The file will have the same file name if you have already loaded that file previously, so it would be best
to create a subfolder in the data and layers folder to contain the generalized data. For example, you
may want to put a LAYERS50PER folder in the 3_LAYERS folder.

Generalized layer folder

In order to generalize any data in Autodesk MapGuide Studio, the generalized file
must be converted to SDF format.
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Sub‐sample Raster Images
The concept of generalizing data does extend to raster images. Using a load procedure to load raster
files, or images, you have an option to sub‐sample the images to a percentage of the original image.
For example, when you load five TIF files, you can sub‐sample them to 25 percent of the original
images together and point to those new files on the server with a raster catalog. With the new smaller,
but fuzzier, images, you can turn them on at a much smaller scale and increase performance of your
maps.

Autodesk MapGuide Studio Sub‐sample Images dialog box

Sub‐sampled images reduce the size of the files and will decrease the amount of data that is requested
from the Autodesk MapGuide Enterprise server, and will increase the performance of Autodesk
MapGuide Enterprise.

Be cautious when sub‐sampling. The data that is sub‐sampled can lose a tremendous
amount of accuracy.

Example of Sub‐sampled images
Here is an image that has not been sub‐sampled.
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This image has been sub‐sampled at a scale factor of 2, or 25 percent of the orginal resolution.

Sub‐sampling reduces the size of raster data files enabling you to make images available at smaller
scales, thereby giving the Autodesk MapGuide Viewer users map data much sooner. As you zoom in,
you can use scale ranges to turn off the fuzzy image and turn on the clear one.

AJAX Base Layers for Smooth Navigation
Each time a user pans or zooms within the viewer, data is requested from the Autodesk MapGuide
Enterprise server. There is a subsequent lag in filling in the data requested, especially in the MapGuide
AJAX Viewer (used with Basic Web Layouts and Flexible Web Layouts). To speed up the process of
redrawing the map, you can create a cached set of base layers for the AJAX viewer so that these
layers, based on zoom, will load very quickly, thereby speeding up the refresh of the AJAX Viewer.
Within each map definition in Autodesk MapGuide Studio, there is an option called Base Layers for
Smooth Navigation in AJAX Viewer. This enables you to choose layers and scales for the rendering of
quick layers in the MapGuide AJAX Viewer.

Selecting Base Layer in Studio
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Once you have selected the layers you want to use as base layers, you set up how those layers will be
seen. For example, you may want to hide the base layer group or change its name.

Changing layer setting for Base Layer

Finally, you can set the scales at which the layers are rendered. For example, you can choose a range
between 1:1,000 and 1:30,000 with a rebuild factor that is determined by how many scales you want
to rebuild the map.
Each rebuild of the scale gives a more detailed layer. The Autodesk MapGuide
Enterprise server will generalize dynamically and will become more detailed on each
scale rebuild.

Scales selected between 1,000 and 30,000 in Autodesk MapGuide Studio

The base layers are optional and only work with the Autodesk MapGuide AJAX Viewer, but the
perceived performance results are significant to the user.
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Exercise: Create a Scale Range
In this exercise, you create a scale range for the
parcels layer. The layer will only appear in the map if
you zoom into a scale of 1:25,000 or greater. This will
increase the performance of the map.

2.

In Site Explorer:
■
Expand the folder Library://
REDDING/3_LAYERS/.
■
Right‐click Parcels > Open.

3.

In the Style Area:
■
Click within the To combo box.
■
Enter: 25000

4.

In MapGuide Studio, click File menu > Save
Parcels.
In Site Explorer:
■
Browse to the Library://
REDDING/5_MAPS/ folder.
■
Select the Right‐click REDDING_MAP map
> Open.

The completed exercise

Create a Scale Range
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

■
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5.

6.

7.

On the MapGuide Studio toolbar, click Preview
Mode to open the Map Preview pane.
■
In the Map Preview pane, click Refresh.

Notice that the Parcels layer does not appear
in the Legend and a new 0‐25,000 scale is
available in the Scale Ranges.
In the Preview Map Pane, click the 0‐25000
link on the left to zoom into the map.

The parcels layer appears on the screen and
the parcels are no longer grayed‐out in the
legend.
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Exercise: Generalize a Layer and Add a Layer to Map
In this exercise, you load a Parcel.SHP file and
generalize it by 50 percent. The scale range on the
layer is modified to turn off at a minimum scale of
1:25,000.
Once added to the map, the generalized version of
the parcels appears from 25,000 to infinity and the
original parcels appear from 0 to 25,000 scale.

2.

3.

4.

The completed exercise

5.

Generalize a Layer and Add a Layer to Map
1.
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If not already open, open Autodesk MapGuide
Studio.
In the Site Authentication dialog box:
■
For Site, enter: http://localhost/
mapguide2010
■
For User ID, enter: Administrator
■
For Password, enter: admin
■
Click OK.

■
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6.

7.

In MapGuide Studio:
■
In the Site Explorer, browse to Library://
REDDING/2_DATA/.
■
Click New > Folder.
■
For the name of the folder, enter:
DATA50PER
In Site Explorer:
■
Browse to the Library://
REDDING/3_LAYERS/.
■
Click New > Folder.
■
For the name of the folder, enter:
LAYERS50PER
In Site Explorer, right‐click the //REDDING
folder > New > Load Procedure.

In the Select Files to Load dialog box:
■
Browse to the C:\Projects
\MapGuide2010\Source\ folder.
■
Highlight Parcels.shp.
■
Click Open.
Under How Do You Want to Transform the
Data?, in For SHPs with No Coordinate System,
Use, click Browse.
In the Coordinate System dialog box:
■
For Categories, select USA, California.
■
For Available Coordinate Systems, select
CA‐I (NAD27 California State Planes, Zone I
(401), US Foot).
■
Click OK.

8.

Also under How do you want to transform the
data:
■
For Generalize the Data by This
Percentage, enter: 50
■
Ensure the Convert to SDF Feature Source
is checked.
9. Ensure the destination folder is set to
Library://REDDING.
10. Under To This Path, under the Feature Sources
click the Browse button.
■
In the browse for Folder dialog box, select
DATA50PER
■
Click OK.

12. Under In This Folder:
■
Delete Data.
■
Delete Layers.

13. Click Load Resources.
In Site Explorer:
■
Note that a new Parcels.sdf is created
in the Library://REDDING/2_DATA/
DATA50PER/ folder. It is a 50 percent
generalized version of the original
Parcels.sdf.
■
Note that a new Parcels layer is created
in the Library://REDDING/3_LAYERS/
LAYERS50PER folder using that new file.

11. For Layers, under To This Path, click the Browse
button.
■
In the Browse For Folder dialog box, select
LAYERS50PER.
■
Click OK.

14. Do not save the Load Procedure and close the
New Load Procedure tab.
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15. In the Site Explorer:
■
Expand the folder Library://
REDDING/3_LAYERS/LAYERS50PER/.
■
Right‐click Parcels > Open.
16. In the Edit Pane, under Style, under Scale
Ranges, in the From field, enter: 25000.

17. In MapGuide Studio, click File menu > Save
Parcels.
18. In Site Explorer:
■
Browse to the Library://
REDDING/5_MAPS/ folder.
■
Select the right‐click REDDING_MAP map >
Open.
19. In the Layers area, under Layers by Group, click
Add Layer.
20. In the Select a Layer Resource dialog box:
■
Browse to the Library://
REDDING/3_LAYERS/LAYERS50PER folder.
■
Highlight Parcels.
■
Click Open.
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21. In the Layers by Group area:
■
Highlight Parcels (2) layer.
■
In the Layer Settings within the Map area,
change the name to Parcels Low‐Res.
■
Change the Legend label to Parcels Low‐
Res

Note: In the future, you may want to change
the Legend Label to just Parcels, so the user
cannot tell when the layer and data have
switched.
22. Under Layers:
■
Click the Drawing Order tab.
■
Move the Parcels Low‐Res above the
existing Parcels layer.

23. On the MapGuide Studio toolbar, click Preview
to open the Map Preview pane.
■
In the Map Preview pane, click Refresh to
view the new scale ranges for the Parcels
layers.

Note: The parcels are generalized to an
extreme degree for demonstration purposes.
You may wish to generalize this data at a less
noticeable degree.
24. Click File menu > Save REDDING_MAP.
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Lesson: Data Performance
This lesson covers two types of database indexes: database and spatial. Database indexes, used
to speed up traditional tables, increase the performance of reports and searches. Spatial Indexes
increase the spatial performance of viewing and querying maps and layers in MapGuide.

Indexing non‐spatial data in Microsoft SQL server

Objectives
After completing this lesson, you will be able to:
■
■
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Describe indexes in non‐spatial databases.
Explain indexes in spatial databases.
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Index Non‐spatial Data
Indexing, or sorting, is a technique where a special object in the database keeps track of the order and
sequence of the columns of a particular table. Indexing is one of the most important ways to improve
the performance of a database. Without an index, finding any information would take significantly
longer.
As with an index, a primary key, which is automatically indexed, is also required to improve the
performance of the database.

How to Create an Index
Regardless of the type of database, including Oracle, Microsoft SQL Server and Access, or MySQL, the
way to create an index on a column is always the same.
CREATE INDEX indexname ON tablename(columnname)
For example, if you want to index the Land_Value in the table called Parcels you would enter:
CREATE INDEX IDX_Parcels ON Parcels(Land_Value);
This command works in most databases and increase any searches or themes that use the Land_Value
column.

Exception to Index Performance
Indexes are not always good for the database. Sometimes having an index causes a performance
drag when modifying records. Each time a query modifies a record, the indexes on that table must
dynamically change also. This is not an issue with heavy reporting functions from a database since
most of the queries are read‐only.
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Index ODBC Point Data
When using ODBC point data from a database, the X, Y, and Z columns should have a database index.
With Microsoft Access, you can use the interface to choose a type of index.
Notice in this example that WELL_NO is already indexed because it is a primary key.

Example of indexing the LAT column in Microsoft Access

More than seven indexes on any table reduces the effectiveness of the index.
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Spatial Index for FDO Data Sources
Another technique for increasing the performance of Autodesk MapGuide Enterprise is with spatial
indexes. Many of the FDO data sources available with Autodesk MapGuide Enterprise have their own
internal spatial index. For example, SDF 3.x files are spatially indexed.
Spatial databases, such as Oracle, with its own SDO_GEOM data type, have spatial indexes that not
only sort by column, but also geographically.
Spatial indexes are a special form of index, which is based on coordinates also known as a geospatial
index. Usually these indexes have spatial index types, such as QUADTREE or R TREE. These indexes take
care of wasted space in the database and quickly find a location based on spatial density and area.
Often these indexes are maintained automatically within the database, or, like Oracle, are created with
a spatial index advisor.

Example of a Quadtree index to the 3rd Level

Notice that in the index above, that the small oval is in the index area known as 300.
Where the 3 is the 3rd quadrant of the first grid. The second 0 is the 0 quadrant of the second grid,
and the last 0 is the 0 quadrant of the third grid.

Seven levels in a Quadtree index are often recommended.
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Creating Spatial Indexes
Most spatial features already have spatial indexes such as SDF or SHP. When creating spatial
repositories with Map 3D, spatial data stored in SQL Server, Oracle, and MySQL have spatial indexes by
default.
There are times when spatial indexes have to be created manually. If your data was created with third‐
party software, or just inserted into the database with SQL statements, you would need to create the
spatial index.
With Oracle, to create a spatial index on the GEOMETRY column in the Water_Mains table, the
statement would be:
CREATE INDEX Water_Mains_id ON Water_Mains(GEOMETRY ) INDEXTYPE IS MDSYS.SPATIAL_INDEX
LOCAL;
With MySQL, you would create a spatial index with the following syntax:
CREATE SPATIAL INDEX sp_Water_Mains_index ON Water_Mains(GEOMETRY);
With SQL Server 2008, and its new spatial support, to create an index on the GEOMETRY column, the
syntax would be:
CREATE SPATIAL INDEX SIndx_Water_Mains ON dbo.Water_Mains(GEOMETRY);
Regardless of the type of spatial repository, your maps will appear in MapGuide much faster if the
data has a spatial index.
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Chapter Summary
Having completed this chapter, you can:
■
■
■

Describe the MapGuide Server performance tools.
Use MapGuide Studio to increase performance of the maps and layers.
Descibe how to structure spatial and non‐spatial data to increase performance in MapGuide.
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Chapter

8
Native Google Earth Support
In this chapter, you integrate Autodesk MapGuide® Enterprise with Google® Earth. By leveraging the
huge data repository that Google Earth offers andcombining itwith your own datasets streamed from
MapGuide Enterprise, you create an effective way to visualize data within a world context.

Objectives
After completing this chapter, you will be able to:
■

Explain how to render MapGuide information as KML data in Google Earth.

Chapter Overview

■

239

Lesson: Native Google Earth Support
In this lesson, you learn to use the MapGuide Enterprise map agent to publish to Google Earth. The
MapGuide Enterprise server can publish maps, layers, and data in many ways; one way is publishing to
Google Earth.

MapGuide Redding map in Google Earth

Objectives
After completing this lesson, you will be able to:
■
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Describe how to create KML files to view MapGuide data in Google Earth.
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Publish Maps, Layers, and Features to KML
Autodesk MapGuide Enterprise includes dynamic generation of KML/KMZ files based on existing map
and layer definitions, which can be viewed in Google Earth.

About KML
KML (Keyhole Markup Language) is a file format used to display geographic data in Google Earth,
Google Maps, and Google Maps for mobile. A KML file is processed in the same way that HTML (and
XML) files are processed by web browsers. Like HTML, KML has a tag‐based structure with nested
elements and attributes based on XML standards. Thus, Google Earth and Google Maps acts as
browsers for KML files. Just as web browsers display HTML files, Earth browsers such as Google Earth
display KML files. KML files can be compressed using the ZIP format into KMZ archives.

KML for Parcel layer in MapGuide
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Example
In addition to satellite images, Google Earth provides a large amount of content such as road
networks, points of interest, voting districts, etc. By serving MapGuide data via KML, authors can
incorporate their specific dataset with Google’s.
For example, for a MapGuide dataset containing information about underground pipes and sewers,
this information could be overlaid on a satellite image showing individual streets and houses. This
facilitates the process of estimating exactly which homes and streets would be affected by any
maintenance required on those pipes.

Redding base map in Google Earth

Advantage of Combining MapGuide with Google Earth
Native support for Google Earth provides a simple method of viewing MapGuide maps, layers, and
features in Google Earth. Satellite images, maps, terrains, and 3D buildings included with Google Earth
enhance the value of MapGuide maps.

Process: Publishing Map, Layers, & Features to Google Earth
KML files are generated via GETMAPKML, GETLAYERKML, or the GETFEATURESKMLweb requests to
the MapAgent. To publish maps, layers, and feature sources to KML, you follow these steps:
1.
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Open the MapAgent by accessing the web server extensions site. In your browser, in the address bar,
enter: http://localhost/mapguide2010/mapagent/index.html

■

Chapter 8: Native Google Earth Support

2.

3.

4.

Under Services API, click KML.
Three operations are available under the KML service API: GETMAPKML, GETLAYERKML, and
GETFEATURESKML. GETMAPKML handles the generation of the KML file from the Map Resource, while
GETLAYERKML and GETFEATURESKML handle the generation of the KML file from the Layer Resource
and Feature sources.
Select GetMapKml. Change Map Definition to the map you want to view in Google Earth. Click Submit.

For GetLayerKml and GetFeaturesKML, you need the layer definition in order to generate the
appropriate KML.
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5.

In the dialog box that is displayed, enter a username and password that have access to the map or
layers.
Anonymous login with a blank password is also accepted.
A KML file is generated dynamically. When prompted, click Open.
The Google Earth application launches, automatically “flies to” to the region covered by the MapGuide
Layer definition, and overlays the MapGuide layer data.

6.

You do not need to use the MapGuide Enterprise web server extensions mapagent
site in order to request layers and maps in KML. You can enter the URL of the
mapagent.
For example: http://localhost/mapguide2010/mapagent/mapagent.fcgi?
OPERATION=GETMAPKML&VERSION=1.0.0&FORMAT=KML&DPI=96
&USERNAME=Anonymous&PASSWORD=
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Chapter Summary
Having completed this chapter, you can:
■

Explain how to render MapGuide information as KML data in Google Earth.

Chapter Summary
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Appendix

A
Additional Resources
A variety of resources are available to help you get the most from your Autodesk® software. Whether
you prefer instructor‐led, self‐paced, or online training, Autodesk has you covered.
For additional information please refer to the disc that accompanies this training guide.
■
Learning Tools from Autodesk
■
Autodesk Certification
■
Autodesk Authorized Training Centers (ATC®)
■
Autodesk Subscription
■
Autodesk Communities

Learning Tools from Autodesk
Use your Autodesk software to its full potential. Whether you are a novice or advanced user, Autodesk
offers a robust portfolio of learning tools to help you perform ahead of the curve.
■
Get hands‐on experience with job‐related exercises based on industry scenarios from Autodesk
Official Training Guides, e‐books, self‐paced learning, and training videos.
■
All materials are developed by Autodesk subject‐matter experts.
■
Get exactly the training you need with learning tools designed to fit a wide range of skill levels and
subject matter—from basic essentials to specialized, in‐depth training on the capabilities of the
latest Autodesk products.
■
Access the most comprehensive set of Autodesk learning tools available anywhere: from your
authorized partner, online, or at your local bookstore.
■
To find out more, visit http://www.autodesk.com/learningtools.

Autodesk Certification
Demonstrate your experience with Autodesk software. Autodesk certifications are a reliable validation
of your skills and knowledge. Demonstrate your software skills to prospective employers, accelerate
your professional development, and enhance your reputation in your field.
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Certification Benefits
■
■
■
■

Rapid diagnostic feedback to assess your strengths, and identify areas for improvement.
An electronic certificate with a unique serial number.
The right to use an official Autodesk Certification logo.
The option to display your certification status in the Autodesk Certified Professionals database.

For more information:
Visit www.autodesk.com/certification to learn more and to take the next steps to get certified.

Autodesk Authorized Training Centers
Enhance your productivity and learn how to realize your ideas faster with Autodesk software. Get
trained at an Autodesk Authorized Training Center (ATC) with hands‐on, instructor‐led classes to help
you get the most from your Autodesk products. Autodesk has a global network of Authorized Training
Centers which are carefully selected and monitored to ensure you receive high‐quality, results‐
oriented learning. ATCs provide the best way for beginners and experts alike to get up to speed. The
training helps you get the greatest return on your investment, faster; by building your knowledge
in the areas you need the most. Many organizations provide training on our software, but only the
educational institutions and private training providers recognized as ATC sites have met Autodesk's
rigorous standards of excellence.

Find an Authorized Training Center
With over 2000 ATCs in more than 90 countries around the world, there is probably one close to you.
Visit the ATC locator at www.autodesk.com/atc to find an Autodesk Authorized Training Center near
you. Look for ATC courses offered at www.autodesk.com/atcevents.
Many ATCs also offer end‐user Certification testing. Locate a testing center near you at
www.autodesk.starttest.com.

Autodesk Subscription
Autodesk® Subscription is a maintenance and support program that helps you minimize costs,
increase productivity, and make the most of your Autodesk software investment. For an attractive
annual fee, you receive any upgrades released during your Subscription term, as well as early access
to product enhancements. Subscription also gives you flexible license terms, so you can run both
current and previous versions (under certain conditions) and use the software on both home and
office computers. In addition, Subscription gives you access to a variety of tools and information that
save time and increase productivity, including web support direct from Autodesk, self‐paced learning,
and online license management.
■
Autodesk Subscription offers a way to make software costs predictable. Whether a customer opts
for a one‐year subscription or a multiyear contract, the costs are known for the entire term of the
contract.
■
A complete library of interactive learning tools and high‐quality, self‐paced lessons help users
increase their productivity and master new skills. These short lessons are available on‐demand
and complement more in‐depth training provided through Autodesk Authorized Training Centers.
■
Autodesk Subscription makes managing software licenses easier. Customers have added flexibility
to allow their employees to use their Subscription software—in the office or at home. Better yet,
designers are entitled to run previous versions of the software concurrently with the latest release
under certain conditions.
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Get what you need to stay productive. With web support Autodesk support technicians provide
answers to your installation, configuration, and troubleshooting questions. Web and email
communications deliver support straight to your desktop.
For more information visit www.autodesk.com/subscription.

Autodesk User Communities
Autodesk customers can take advantage of free Autodesk software, self‐paced tutorials, worldwide
discussion groups and forums, job postings, and more. Become a member of an Autodesk Community
today!
Free products are subject to the terms and conditions of the end‐user license
agreement that accompanies download of the software.

Feedback
Autodesk understands the importance of offering you the best learning experience possible. If you
have comments, suggestions, or general inquiries about Autodesk Learning, please contact us at
learningtools@autodesk.com.
As a result of the feedback we receive from you, we hope to validate and append to our current
research on how to create a better learning experience for our customers.

Useful Links
Learning Tools
www.autodesk.com/learningtools
Certification
www.autodesk.com/certification
Find an Authorized Training Center
www.autodesk.com/atc
Find an Authorized Training Center Course
www.autodesk.com/atcevents
Autodesk Store
www.store.autodesk.com

Communities
www.autodesk.com/community
Student Community
www.students.autodesk.com
Blogs
www.autodesk.com/blogs
Discussion Groups
www.discussion.autodesk.com
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